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1 Getting Started

The HMWIN Studio is a software application used to create graphical HMI pages. The HMWIN Studio has a
drag-and-drop interface that makes it easy to create complex display pages. The same features found in
many popular Windows applications are also available in the HMWIN Studio.

This document describes how to use the HMWIN Studio application, and is divided into chapters that
represent the key operations of the HMWIN Studio. Each chapter is presented in a standalone manner,
allowing you to jump from chapter to chapter, depending on the task you wish to perform.

1.1Assumptions

We assume that those reading this manual are using the HMWIN Studio software to design control panel
applications that run on HM panels and on PC.

We also assume that you have a basic understanding of PCs, Microsoft Windows, and the type of network
environment in which you will run the application.

1.2Installing the Software

The HMWIN Studio contains the following as part of the installation:

HMWIN Studio
HMWIN Studio is an application for designing custom HMI projects in a user-friendly manner, along with a
variety of options in its built-in library, the Widget Gallery.

HMWIN Client
HMWIN Client is a light-weight application that can be used on Windows computers to remotely view and
manage an application running on an HMI Runtime.

HMI Runtime

The HMI Runtime is a standalone application that runs on the HM HMI panels. The HMI Runtime can be
installed via HMWIN Studio and is design for working with WCE 6.0 OS.

1.2.1 System Requirements
HMWIN Studio has the following system requirements:

Operating System  Windows XP (SP2 or SP3)
Windows Vista (SP1 or SP2)

Windows 7
Windows 8
Storage 500 MB Min
RAM 512Mb
Other One Ethernet connection
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1.2.2 Installation

Insert the CD-ROM into the CD-ROM drive. If your system has Auto run enabled, the HMWIN Studio
installation will start automatically; otherwise run the HMWIN Studio setup application.

1. Click on the Start button and select Run from the popup menu.

2. Type D:\setup in the box if you are running the installation from the CD drive (if your CD-ROM
drive is not drive D, replace with the appropriate letter).

3. Click Next.

I T P R T N N W T

(71T accept the agreement

@ I do not accept the agreement

Figure 1

4. Read the HMWIN Studio Software License and accept the agreement.
5. Follow the instructions on the screen. The default location for the HMWIN Studio software is
C:\Program Files\Panasonic\HMWIN . Default installation path can be changed depending on needs.

6. If the Select Components step is available, select the components you want to install.
7. The installation procedure will create a program group called HMWIN Studio in the Start menu. A
HMWIN Studio icon can be added to the desktop.
Figure 2

At e Pl e T e L et ey e ey T e et e P e e

Additional icons:

Create a desktop icon!

Figure 3

After installing the HMWIN Studio, you can run the application by using the desktop icon or from Start > All
programs > HMWIN Studio.

1.2.3 Licensing

HMWIN Studio is available with a friendly 30 days free trial policy. After 30 days since the installation the
system will present a registration form where you can enter license activation keys.

Message shown after trial has expired and no valid licenses are found is: Invalid license: license not
found. To register software before trial period expires, goto Help -> Register.

NOTE The registration process requires an Internet connection. Ports TCP 80 and 443 are used for
activation.
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When HMWIN Studio performs the registration, a license file is downloaded from the License Server to the
PC. License files are saved in following folders depending on OS:

e C:\Documents and Settings\[username]\Application Data\ Panasonic\
o C:\Users\[username]\AppData\Roaming\Panasonic\

Licenses are locked to the BIOS ID or to the Windows product ID of the PC where HMWIN Studio is
installed

If HMWIN Studio is not able to reach the server (for example because no Internet connection is available), a
new button appears; it can be used to activate the license via email. This mail can also be shared with
technical support for assistance.

M Send an Email....

Flease Send an Email as below:

Ta: license@:-Formation. carm

Subject: Request License for HMIStudio

Body: ACTIVATION_KE'Y:
HOSTIDBIOS=YMware-S64dbodcaed55ftf -Seat3d 7 oeaddtetz

A license will be emailed to you after verifying the activation code is valid and reqgistering the product,
Flease place the license file in the Folder C:\Documents and Settings!,admin' Application Datay, ...

Figure 4

To verify the status of an activation (in case of problems) is possible to introduce the Activation Key in the
following URL: https://license.x-formation.com/licenses

From this website is possibile also to download the license file once activated and later save it in one of the
following folders (based on OS):

e C:\Documents and Settings\[username]\Application Data\ Panasonic\
e C:\Users\[username]\AppData\Roaming\Panasonic\

NOTE Trial is not supported in virtual machines. However, with a valid license virtual machines are
supported.
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1.2.4 Installing Multiple Versions of HMWIN Studio on the Same Computer

You may install different instances of HMWIN Studio on the same computer. Each installation has its own
settings and can be uninstalled individually.

During the installation process you may encounter three scenarios:

1. Firstinstallation of HMWIN Studio in the system
The installation procedure asks for the destination folder and installs that software in the specified
folder.

2. System with only one instance of HMWIN Studio already installed
The installer detects that one version is already available and it will ask if you want to replace the
current version with the new one or if you want to install another instance.

3. System with multiple instances of HMWIN Studio already installed
The installer detects that one or more installations of HMWIN Studio are present and it will ask if you
want to replace the last installed instance with the new one or if you want to install another instance
(Figure 5).

( Setup L.J1

| Setup has detected a previous installation. Would you like to REPLACE
' current version with new one 7

Yes, It will replace current version,
M, It will leave current versicn unchanged,

L &

Figure 5

When the user tries to install a second instance of the same version of HMWIN Studio, the setup
procedure will detect it and will show a warning message that the same version is already available
in the computer. Setup will also provide the user with the reinstall option (Figure 6).

( Setup l ]1

L -

Figure 6

Each installation goes to a sub-folder which has the version number as part of its name; for instance:

C:\Program Files\Panasonic\HMWIN 1.90.
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Each installed version provides its ID in the Control Panel. Add/remove program facility is provided
in order to remove it individually from the computer.
Each installation identifies itself in the Start Menu with a program group name.

NOTE Multiple Studio installations provide a common workspace folder for all instances of the
HMWIN Studio that have been installed.

1.2.5 Opening Projects Created with Older Version of HMWIN Studio

When a HMWIN Studio project (file with . jpr extension) is opened, HMWIN Studio checks for the match
between the version ID stored in the jpr file and its version ID; if they match, the project will be opened
normally; if they do not match, HMWIN Studio shows a warning message to inform that the project has been
created with a different version of HMWIN Studio and report this version ID if it is available in jpr.

In this case HMWIN Studio will offer two options to convert the project:
e Convert and open the project from current path. The project will be converted without a backup copy
of the original version.
e Convert and save the project to a new location and Open. The older version is maintained as a
backup copy.

( Warning [i_E-r

The project was created with a Version 01,80.00.21

@ iConvert and overwrite current project

Select a new location before converting the project

Convert ]| Cancel

Figure 7

WARNING Do not edit projects with a version of HMWIN Studio older than the one used to create them.
It can result in a damage of the project and to runtime instability.

1.2.6 Multilanguage for HMWIN Studio

Starting from v1.91 HMWIN Studio is available in Multilanguage. All languages are installed by default as
part of HMWIN Studio.

To change default language (english) used by HMWIN Studio go to Help -> Change Language and change
current with preferred language.
1.2.7 Crash report

Crash report dialog appears automatically in case HMWIN Studio freeze or crash and allows users to save
a log file of crash. The crash report may contain information important for technical support.
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NOTE Crash reports are disabled in Windows XP OS

ACGMO195V1EN
HMWIN Studio User Manual

16



2 The HMI Runtime

The HMI Runtime is designed to support different platforms and different operating systems.

All the panels are running today on the base of the Windows CE operating system (Version 6 R3). The
operating system and all its options are built around the minimum set of requirements of the HMI Runtime;
there is no option to get direct access to the Operating system settings as all the needed components are
managed via the runtime itself or via HMWIN Studio.

Later in this document you will find more information on how to install the HMI Runtime and how to manage
the update of other system components (firmware) on the units, but always with a dedicated interface which
prevents a direct access to the operating system, often a source of complexity.

2.1 Runtime Modes

The HMI Runtime is composed of two logic units: the server and the client. The client unit is the part which
is responsible for the visualization process: using the data collected at the server side to render it on the
display as graphical information. The server unit is responsible for handling the HMI services such as
running the communication protocols, performing data acquisition, driving trend buffer sampling activities,
monitoring alarms, and so on. The server unit of the HMI Runtime can be in one of two operating modes:

e Configuration Mode: the server is idle; activity has not started; for example no project is loaded on
the panel or system files are missing.

e Operation Mode: the server is active; it is operating according to the settings defined by the system
files and by the application project.

The server operating mode is independent of the client side operating mode; you may have a visualization
running but server activity stopped.

2.2Basic Unit Settings

The settings of the device are available from the Show system settings menu, which is accessible from the
Context Menu, if the panel has the runtime already installed, or by using the dedicated button on the unit
when in loader mode (see for this the chapter “The Runtime Loader” below in this document).

Press and hold your finger on an empty area of the screen for few seconds, until the Context Menu appears
as shown in the figure.

£oom In
£oom ot
Zoom 100%:

Pah mode

Settings...

Project Manager...
Update, ..
Backup/Restore
Logging

Shiow Log at Boot:

Shiowe systern settings

About, ..
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Figure 13

Select Show system settings to access the system settings tools.

System settings

a1
01
0000
ydule detected

Calibrate Touch

Figure 14

The System settings tool is a rotating menu through which you can scroll using the “Next" and “Back"
buttons. It includes the following entries:

Calibrate Touch To calibrate the touch screen if needed

Display settings Backlight and Brightness control

Time Internal RTC settings

BSP Settings Operating system version, Unit operating timers: power up and activated
backlight timers, Buzzer control, Battery LED control

Network IP address settings

Plug-in List Provides a list of the plug-in modules installed and recognized by the
system; this option may not be supported by all platforms and all
versions.

2.30ther Context Menu Options

The context menu has several other options:

Zoom In/Out/100%
Select view at runtime.

Pan Mode
Enables/disables pan mode; works only when you have previously activated a zoom in.

ACGMO195V1EN
HMWIN Studio User Manual 18



Settings
Following runtime settings are available:

Context Menu The context menu activation delay. Range is 1-60 seconds.
Delay (sec)

Show Busy Cursor When enabled, shows an hourglass when the system is busy

Use keypads When enabled, shows touch keypads when users touch/click on fields
for data entry. When disabled, does not show any keypad on screen
(useful when an external USB keyboard is connected to device).

Password Change the password protecting operations such as:
- Download Project/Runtime
- Upload project
- Board management (BSP Update)

Please ref. to Remote access protection to HMI Panels for more
information related to access protection.

Settings

Seffings | Password |
Context Menu Delay(s): [2 |« ]» |

Show Mouse Pointer:

Show Busy Cursor: []

Use Keypads:

oK || cancel |

Figure 15

Project Manager

When activated, a dialog box will appear (see figure below) providing options to unload (de-activate) the
current project, load (activate) another project present on the panel memory, or delete a project.

Please note that projects can be deleted only after they are unloaded. If you click on a project name other
than the active one, the option "Load project” will first unload the running application and then automatically
activate the new one.
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Project Manager, E]

i fworkspace ABEMET_TEST
[ warkspace\Project1

UnLoad Project| |Load Project | |Delete project

Figure 16

Update

When activated, the panel verifies first the presence of an external USB pen drive inserted in the panel USB
port, and later for the presence on its root folder of the update package. See the “Updating Runtime from
USB Pen Drive “chapter in this document for further information

Backup
Creates a backup copy of runtime and project.

Logging

Enables you to display a trace of the system operation log; it may be very useful in case there is a need to
debug a problem of any nature. The following figure shows a case in which the system reports a
communication error; the decoding of the reported information may not be immediate, but you can always
use the option “Log to file” to save the dialog context to a file that can be later provided to Technical Support
for investigation. The log file is called “logger.txt” and it saved to the folder “...\var\log” on the panel flash
disk. The file can be retrieved from the panel using an FTP client.

NOTE The “Log To File” Option is saved and retained after power cycles; when not needed any more, it
must be manually deactivated.

1

CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (updateTags):
CProtocol (undateTaosh:

[ABEM] readBlock failed:
[ABEM] readBlock failed:
[ABEM] readBlock faled:
[ABEM] readBlock faled:
[ABEM] readBlock failed:
[ABEM] readBlock failed:
[ABEM] readBlock failed:
[ABEM] readBlock failed:
[ABEM] readBlock faled:
[ABEM] readBlock faled:
[ABEM] readBlock failed:
[ABEM] readBlock failed:

Errar TimeoLt | a
Errar Timeout
Errar TimeoLt
Errar Timeout
Error Timmeout | |
Error TimeoLt
Errar TimeoLt
Errar TimeoLt
Errar TimeoLt
Errar Timeout

Errar TimeoLt
Error Timﬁuilﬂ
3

Log to File

Figure 17

Show log at boot
Enables the logger at start up; if the “Log to file” option has been enabled, the files are saved, in this case,
from the startup phase.

Developer tools
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It is a collection of utility functions useful for debugging problems at runtime.

About
Shows information about the runtime version.

2.4Built-in SNTP Service

The HM Panels Operating System features an integrated SNTP (Simple Network Time Protocol) that
synchronizes the internal RTC panel whenever the predefined server is available.

The server addresses are hard-coded and cannot be changed by the user. The system searches for the
following servers:

e time.windows.com
e tock.usno.navy.mil

SNTP servers are checked at power up, or once per week if the panel is not powered off.
NOTE Starting from WCE v1.76 ARM / 2.79 MIPS is possible to customize up to two SNTP servers from

System Mode (MainOS) accessible via Context Menu -> System Settings -> Time -> SNTP tab. This setting
is not available in Configuration Mode (ConfigOS).
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3 My First Project

This section describes the steps to create a simple HMWIN Studio project.

3.1Creating a New Project
To create a new project, click on the File > New Project menu item.
The Project Wizard dialog will appear, asking for a project name and a path where the corresponding project
folder will be stored.
HMWIN Studio projects are stored in a folder that has the same name as the project. This folder contains all
the files of the project. To move, copy or backup a project, you can simply move or copy the project folder
and all its contents to the desired location.

NOTE DO NOT rename the HMWIN Studio Project folders manually. If you need to rename a project, use
the File > Save Project As function. Depending on the size of the project, this could take some time.

Click Next to go to the panel selection dialog.

Project Wizard ﬁ

Fanels

HMI Targetl Panel size: 430 % 272

HMI Target2 Panel type: UN31_SDK (ARMY4L)
HMI Target3
HMI Targetd
HMI Targeth
HMI Targets

o4 | 980 |§ —
ill[272 @ Landscape -:-_F‘Drtrait
[ Back ] [ Finish ] [ Cancel
W A

Figure 18

The panel selection is shown in the figure above. Here, you can scroll through a list of available HMI models
to select the model you are working with.

For each model, two radio buttons are available to select the orientation: landscape (default) or portrait. In
portrait mode the device is rotated 90° clockwise.
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Some software features are not rotated when portrait mode has been selected. A list of these features is
shown in the table below.

WCE dialogs all dialogs related to “System Settings”

System Dialogs ex. System Mode

i?g:ggtg?aelgl;:nd Project Manager, About, Settings, Logging, Backup
Video Analog Video Input, IPCamera, MediaPlayer
JavaScript Alert and Print function

Dialog pages “Title” of dialog pages

Scheduler Dialogs for data entry do not support portrait
Macro ShowMessage, LunchApplication, LunchBrowser
E;)‘.)([t:ﬁircr:];lions PDF Reader, VNC

Click Finish to complete the Wizard.

Once the HMI model is chosen, you can convert the project to any other model, using the project properties

portion of the screen, as shown below. This will not resize all widgets in the project to the correct size to fit a
smaller or larger screen; it will simply change the model type and give a warning if some objects will be lost

during the conversion.

Properties o x

&1 &f &7

= Project Widget

Id Projectl
Full Path
Version

Context Menu on delay

Image DB Enable true

=l Behavior

Home Page Pagel.jro
PagewWidth 1024

PageHeight 768
Display Mode Landscape

B CroeccTvee IS [+
PageRequest Convert Project
CurrentPage

Figure 19
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3.2The Workspace

The HMWIN Studio workspace is divided into following main areas:

Project View Presents the elements of theprojec in the form of a hierarchical Project
Tree.

Object View Lists the Widgets with the corresponding ID’s used in the page.

Working Area Main working space where editors create the HMI pages. The current

page or pages opened in the Editor View are indicated by a tab at the
top of the center area. You can quickly switch between the different
pages in the Editor View by clicking on the desired tab.

Properties Properties for the selected object / widgets

Widget Gallery Large library of symbols and graphic objects.

i File Edf Run Format  View Window Help

+ - 4 A
- % Praject]
i@ Projectl

S 9 Pages
B 1 Pagel

= Config
£\ Protocals
— Tags
B Trends

B s

i
5

Aeneg 80P ¥

MR

Heght 480
Bkgd Color  |[ [255, 255, 255
Templite none

= Ewents

o Events Buffer

7T Scheduler

% MultiLanguage
i Security

& WserGroups

1 Users
B Recipes Working Area
¥ Dictioranes

¥ DislogPages
£ Page Temnplates

Properties Pane

Project Tree

Ready

Figure 20

The workspace layout can be freely changed at any time; any change is saved and maintained among
Studio activations. In case you need to reset the workspace to the original default layout, use the command
called Reset and Restart under the File menu.
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File | Edit Run Format View Wi

HNew... Ctrl+N

4
[ﬁ Dpen... Ctrl+=C
5|

Mew Project...

D

Save Project Ctrl+5
Save Project As...
Close Project

1 ChUsersh,. AauditTraildl
2 Chldsersh AProjectlProjectl

~Reset and Restart ¥

Exit

Figure 21

3.3Communication Protocols

Device Communication drivers are configured in the Protocol Editor, which is accessible from the project
tree (as shown in the figure below). Double click on the Protocols icon in the Project Tree view to open the
Protocol Editor.

To add a driver, click on the “+" Icon and select the driver from the list in the controller field. Once a
communication driver has been selected, configure the driver by clicking on the browse button in the column
Configuration. A configuration dialog will be displayed, allowing you to set the parameters of the driver (as
shown in the figure below).

ProjectView o x protocols

- A5 AW g - AW
=-B8 Projectl [PLC | Configuration

|G Projectl

L Lot
|:_:| il n} |:

-84 Trends
Figure 22

As an example, to create a project for Modbus TCP, you would select the Modbus TCP driver and then
configure the communication parameters by selecting the browse button in the Configuration column.
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PLC | Corfiguration | Tag Dictionany’

|HMadbus TCP prot [CfaVer=1 port=502 timeout=2000 modbusUnitID=
[ Modbus TCP % ]

[ PLE Metwark
Alias |
IF address | 0.0 .0 .0
Port 502
Timeout (ma) |2EIEIEI
Modbus 1D | 1
Max read block 254
Preset function [Elﬁ ,]

PLC Models

Generic modbus

Figure 23

HMWIN Studio configurations that include more than one communication protocol. By repeating the steps
previously outlined, you can add up to four protocols in the Protocol Editor.

NOTE while it is possible to run different Ethernet protocols over the same physical Ethernet port, you
cannot run different serial protocols over a single serial port. Some serial protocols support access to
multiple PLCs, but this is an option that has to be configured within the protocol and still counts as one
protocol.

The Other parameters in protocol editor are:
e Tag Dictionary: tags imported for a particular protocol. Ref. to chapter Dictionaries for more details
¢ Enable Offline Algorithm / Offline Retry Timeout: ref. to chapter Offline Node Management for
more details

e Version: version of the protocol available in HMWIN Studio for selected target. Version of the
protocol is not read from hmi directly but from studio internal DLLs.

3.4Tags

HMWIN Studio uses Tag names to access all device data. All fields and reference locations in the device
need to be assigned a Tag name to be used in the HMI. To assign Tags, double click on the Tags icon in the
Project View and the Tag Editor will be displayed (as shown in the figure below).
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ProjectView a X 1:Pagel protocols® Tags =

+ - £ A VY lp — Av|XB B> |[edusCPant -]
| Name | Group | Driver

..... }f Events Buffer
..... ¥ Scheduler

..... 2 MultiLanguage
=15 Security

..... [ Recipes
..... [/ Dictionaries

..... [ DialogPages
----- F"H Page Templates

Figure 24

To add a new Tag, click on the “+" icon, and select the Address from the Communication protocol address
dialog. When Tags are initially added, these Tags are named Tagl, Tag2, etc., by default. The user can
rename the Tag with the appropriate name by clicking once on the Tag name.

The Tag Editor provides a Tag Import feature, which is available based on the protocol selected. Not all
protocols support Tag Import. If the protocol does support this feature (see specific Protocol
documentation), first select the Protocol from the filter button and then click on the Import button (as shown
in the figure below).

+ = A vk B W |PI> [Modbus TCPprot1 ~|&]
|Name | Group | Diriver | Address Comment |

Select Controller Modbus TCP

Select Impart Type *.csv

Figure 25

You will see the dialog that corresponds to the protocol selected, which prompts you to browse for the
symbol file. The symbol file is exported from the controller programming software.
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3.4.1 Tag Editor

The tool in HMWIN Studio used to create and manage tags is called the Tag Editor.
For each tag, the Tag Editor allows you to specify several properties:

Name

This is the unique name at the project level of the tag. This is the primary key used to identify the information
in the internal runtime tag database. Note that you cannot use the same tag name even if you are referring to
different communication protocols.

Group

After the tags have been defined in the Tag Editor, they are used in the project by attaching them to the
widgets' properties (see chapter “Attach To” for a complete explanation).

For each screen the system is able to identify which tags are used in the specific page and identifies them as
part of the "page group". This allows easy handling at run time of the requests made by the communication
protocol to the connected controller(s): only the tags included in the displayed page are queued for polling
from the controller memory.

This mechanism is fully automatic and there is no intervention required by the user.

The tag editor allows you to define groups of tags not belonging to a specific page but, for instance, grouped
according to their logical meaning.

We can call these groups "Users' groups”. Users' groups have no meaning for the local visualization, but
they are very useful when external software communicates with the runtime requesting sets of data that must
be independent from the currently displayed screen.

The Runtime web server publishes a set of communication interfaces that can be used from a 3" party
application to interface with the local tag database and read the tags according to their grouping.

The group column allows you to define the users' groups and assign tags to them.

Driver
Specifies the communication protocol for which the tag is defined.

Address
This shows the PLC controller memory address. To edit it, click on the right side of the column to get the
dialog box where you can enter the address information.

Encoding
Encoding type for string data type (UTF-8, Latinl, UTF-2 and UTF-16)

Comment
Allows you to add a description of the tag.

Rate (ms)
Define the refresh time for tag. Default is 500ms that means tag is updated every 500ms.

R/W

This option determines if the tag must be managed as Read only (R), Write only (W) or Read/Write (R/W).
When a Tag is Write Only (W), the system never reads the tag value (& status) but can only write it. When
communication is not active, content of Write Only tags may not be available in widgets.

Active

As explained above, tags are grouped per page and, if needed, in users' groups. By default, tags are not
active (are not read from the controller); this means they are automatically activated by the runtime when the
visualization requires them (for example when used on current page). You can force the system to
continuously read a certain tag even if not present in the current page by setting its Active property to true.
We recommend that you normally leave this parameter to false to avoid unexpected results in terms of
communication performance.

Simulator
HMWIN Studio provides online and off-line simulation. The behavior of each tag during offline simulation
mode can be specified by choosing between several profiles.
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Scaling

Tag values are normally transferred "as they are" from the protocol to the real time tag database. You can
specifically apply scaling to the tag values before they are stored in the database. The available scaling
options are By formula and By range. Scaling can be specified in terms of linear relationship as a formula
or as range conversion.

The tag name must be always unique at the project level; often it may happen that the same tags, from the
same symbol file have to be used for two different controllers. Since having tags with the same name is not
supported, you can use the “Alias” feature to automatically add a prefix to the imported tag to make them
unique at the project level.

When importing tags for a Protocol, the tag names may be prefixed by the name given in the “Alias” item of
the protocol configuration dialog box. Please note that not all protocols support the “Alias” feature. See
protocol documentation for specific information.

PLC Tag Name

This is the original name of the tag when imported from PLC. This field is managed automatically by Tag
Importer and is available as R/W in advanced view just to allow users to change it if any problem during tag
import operation. For tags not imported from external files usually this field is empty and can be ignored.
PLC Tag Name are used so as link between tags used by HMI application (Tag Name) and tags exported
from PLC.

3.4.2 Data Types

When creating a tag, HMWIN Studio shows a dialog box in which you need to specify the tag properties. The
tag Memory Types are specific to the selected Protocol.

The tag Data Type must be selected from the list of available HMWIN Studio Data Types, according to the
internal representation you need for the selected controller address. HMWIN Studio Data Types are
summarized in the following table.

Data Type Description

string Character strings. The characters are coded in UTF-8 format.

boolean Boolean is one bit data (0..1)

float Float corresponds to the IEEE single-precision 32-bit floating point type
(1.17e-38 ... 3.40e38)

double Double corresponds to IEEE double-precision 64-bit floating point type
(2.2e-308 ... 1.79e308)

binary Binary represents arbitrary binary data

int Int is signed 32 bit data (-2.1€9 ... 2.1€9)

short Short is signed 16 bits data (-32768..32767)

byte Byte is signed 8 bits data (-128..127)

unsignedint Unsignedint is unsigned 32 bit data (O ... 4.2e9)
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unsignedShort

UnsignedShort is unsigned 16 bit data (0..65535)

unsignedByte UnsignedByte is unsigned 8 bit data (0..255)
time Time data

boolean [ ] Array of Boolean

byte [] Array of byte

short ] Array of short

int[] Array of int

unsignedbyte [ ] Array of unsignedbyte

unsignedshort [ ]

Array of unsignedshort

unsignedint [ ]

Array of unsignedint

float [] Array of float
double [] Array of double
time [] Array of time

3.4.3 Dictionaries

A dictionary is a list of tags imported in the tag editor for a specific protocol. Usually these files are generated

by 3d party tools and are in .csv, .xml or other formats. Refer to Tag Import section of each protocol for
details related to supported formats.

Dictionaries folder in ProjectView list all files imported in the tag editor for each protocol. Selecting a
particular protocol, it is possible to delete or look at the imported dictionary files for the related protocol.
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ProjectView o x 1iPagel | protocole Modbus_RTU x|

+ ' Dictionary Name:Modbus_RTU ' Protocol Mame:Modbus RTU
== .P'_'D-le“.za n tagname nodeid | Memary type | amayindex subindex | Data type
[ Project28 L 1 HREG 400001 unsignedShort
(-7 Pages |MRTUZ2 1 HREG 400002 unsignedShort
..... = DialogPages |MRTU3 1 HREG 400003 unsignedShort
..... @ Page Templates |WRTU4 1 HREG 400004 unsignedShort
..... = Mobile Pages |MRTUS 1 HREG 400005 unsignedShort
- Config _|MRTUS 1 HREG 400006 unsignedShort
£ S _|MRTU7 1 HREG 400007 unsignedShort
Egg' securty | |MRTUS 1 HREG 400008 unsignedShort
&-'gg AuditTrail MRTUS 1 HREG 400009 unsigned Short
""" 7 Recipes _[MRTU1D 1 HREG 400010 unsignedShort
-/ Dictionaries [MRTU11 1 HREG 400011 unsignedShort
ﬂ Modbus RTU  |[MRTU12 1 HREG 400012 unsignedShort
ﬂ Modbus_RTU_1 |MRTU13 1 HREG 400013 unsignedShort
-t § it : e 00015 reedoot
LAl Medbus TEP n unsignedShort
; ?1 Dd He- | [MRTU16 1 HREG 400016 unsignedShort
- Keypads MRTU17 2 HREG 400017 unsignedShort
Figure 26

To import a new Dictionary proceed as follow in Tag Editor:

From top toolbar, select interested protocol

Click on >] button to call importer

Verify controller type and select format of file to import (.csv, .txt, .sym — protocol dependent)
Click OK

Select file to import

aghrwNE

As result, a new dictionary file is added to the Dictionaries folder and a list of tags imported are available in
the tag editor and shown at the bottom of the tag editor page. Tags shown in dictionary can be imported into
the project using following:

e Import Tags (to add new tags to the project)

e Update Tags (to update tags already imported previously)

NOTE When importing tags, the "." period is replaced with a "/" forward slash character. This is normal and

the protocol will use the correct syntax when communicating to the PLC. The "." is a reserved character and
cannot be used in a tag name.

NOTE The “&” ampersand character cannot be used in a tag name, as it can cause communication issues.

3.5Designing a Page

When a project is created, a page is automatically added to the project and shown in the Page Editor. To
add objects to a page, simply drag and drop the objects from the Widget Gallery to the page.

To add a new page, right click on the Page node from the project tree and select “Insert new page”. A dialog
box will appear asking for the name of the new page.
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Page |

5 Blank Page Fage Name
Page?

Figure 27

3.5.1 Importing a Page

A page can also be imported from another project. By right clicking on the page folder in the Project View,
you will see an option named “Import Page”. Please refer to the Figure below.

=8 Project?
-[Eg} Project2

Insert Mew Page...

[_]Fa, C Create Group
..... Import Page

..... ;f' Events Buffer
5% Scheduler

..... f MultiLanguage
..... Screen Saver

=-f5 Security
b IR HearGrmnne

Figure 28

After selecting a page to be imported from the desired project, when you click OK, you get a warning
message in the editor as shown in the figure below.

ra '
HMIStudio eS|

Imported Page has some MacroActions and Datalinks. Import page
does not have the support for importing MacroActions and
Datalinks. Do you want to remove those links from page ?

I Yes I [ Mo

L A

Figure 29
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Page Import can support only import of the page and the widgets in it, but not the Macro actions and data
links attached to the widget. By selecting “Yes” all the data links and the Macro actions attached to the
widgets will be removed. Only the Widgets will remain. By selecting “No” the macro actions and the data
links will remain attached to the widgets, but may not function properly during runtime, unless the tags
associated with the Macros and data links are present or created in the new project.

NOTE The page import can be done between projects made in the same version of the software. If the
versions are different, a warning message will pop up to save the project in the new version, and then try
again to import the page.

3.5.2 Dialog Pages

Dialog pages are windows opened at runtime on top of the current page when requested by the application.
Dialogs are used to inform user about something happening (ex. alarms/notifications/status errors) or to
allow user to answer a question.

Dialog type can be defined in the property window of each dialog and can be:
e Modal: user cannot return to main project window/page until dialog is closed.
¢ Non-Modal: user can continue to use main project window (or other dialogs non- modal) while a
dialog is shown on top of it.

ProjectView ax 1:Pagej/ Page3* x| w Properties
-2 AV o
+ -4 @ Q& o - X 05|06 e B ke (65 &
=B Project30 - = Dialog
-G Project30 M= © & = | Font [Tahoma 12 A B I E == name Page3
E,Pa ;agle; - DialogType non-modal
i :Pag
H Width
L. 2:Pagel ‘ 10
=1 DialogPages e 300
) bage3 Background Color [ [255, 255, 255]
ﬁ Paged JavaScript Debug false
. Pages Title Bar true
3 Pageb Title Name Page3
.. Pagel
= P:Q:ﬁ c = Runtime Position
- PageTgemplates Runtime Positioning false
.[#™ Mobile Pages . 2
=1 Config M 0
£\ Protocols [= Events
2] Tags OnActivate Action
g ;;Zn:r:s OnDeactivate Action
Q Alarms
}f' Events Buffer
% vrimgrce | [ o I ciose |
%2 MultiLanguage
. Screen Saver

Figure 30

Max number of dialogs allowed is reported in Table of functions and limits. When max number of open
dialog has been reached, the runtime will close automatically the oldest dialog open to open the new one.

A dialog can have a Title Bar on top of it. When Title Bar is enabled (Title Bar = true), a Title Name may be
shown.

Runtime Position can be used to specify a fixed position for the dialog window.

3.6 The Widget Gallery

The Gallery is adjacent to the Property View panel and can be opened by clicking on the Widget Gallery tab
(as shown in the figure below).
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Figure 31

Select the desired object from the Widget Gallery, then drag and drop it on the page.
To change the appearance of the object, select the desired property from the property pane and change the
property settings.

All the HMI objects required to build an application are available in the Widget Gallery. The Widget Gallery is
accessible as a slide in pane from the right side of the workspace (as explained in the previous chapter).
The gallery is divided into several categories, each with collections of different types of objects.

Click on a category to display its sub-categories.

For each sub-category, the gallery offers the option of applying different styles to the objects within that
category (when possible).

The figure below shows the Widget style button for round gauges.
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Figure 32

Clicking on the style button will display the available styles for the current object.

Select one of the available styles to apply it to the gallery objects.
This is done using the Page Toolbar shown in the figure below.

NOTE Style change may not be available for all widgets.
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Figure 33

Once on the page, the object can still be subject to additional style changes.

This is done using the Page Toolbar shown in the figure below.

Depending on the object selected, you can have options for the style, frame, fill color...along with the font
type and size and other standard object properties

NOTE Some widgets are composed of many sub widgets. For example a button is a complex widget
composed by two Image widgets, a button widget and label. This is clearly visible in the ObjectView when
the widget is selected. To select a sub widget like the label in a button, use ObjectView or Shift + leftClick of
mouse. In this way sub widget can be changed without ungroup all widget.
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Figure 34

3.7 “Attach To” and Dynamic Properties

HMWIN Studio allows for simple binding between Tags and Widget Properties. Many different Widget
Properties can be attached to a Tag, which allows you to control the device and animate objects based on

live data.

To attach a Tag to a property, click on the property in Property view. A [+] button will be displayed on the
right side of the property. Click on this button and select the item Attach To... from the menu (as shown in

the figure below).

For example, when working with a gauge object, the most common action taken by the programmer is to
attach a Tag to the needle, so that the value of the Tag referenced in the controller memory is represented
by the needle movement.

w Properties o = m
C e B E o ® 8OO s
. - Gauge \ a
/ D Value |25 r: o
- . L
B w W] . Attach To... 'z
r Max
100
2 I Ll e Events
b Configure
" les ¥ Displa
piay
|
| &
[ | L | |
Figure 35

To attach the Tag to the needle, single click on the object to display its properties in the Property view.
Locate the Value property and click on the [+] button on the right part of the field as shown in above figure.
Select the Attach To... menu item and a dialog will be displayed as shown in the figure below.
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Figure 36

When attaching a Tag, you can attach four types of data sources:

Tag: tag defined in the Tag editor

System: predefined system tags (example date and time)

Widget: connect to a widget property (example: value of a slider widget)
Recipe: recipe data from Recipe Manager

Select the Tag from the Tag list and Click OK to confirm.

Tags can be attached to many different properties of the object. You can attach a Tag to a property by

selecting the property in the Property view and clicking on the Attach To or you can right-click on the object
and select the Attach To... menu item.

NOTE A chapter in this document describes in detail the “Attach to” concept.
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4 The HMI Simulator

The HMISimulator provides the ability to test the project functionality before downloading it to the panel. This
feature is useful to test the project when no PLC or HMI hardware is available and to speed up development
and debugging of projects.

The HMI Simulator support online simulation in communication with real devices (PLC based on Ethernet or

RS-232 based protocols) and offline simulation (where using Tag Editor -> Simulator field allows the
configuration behavior of each tag in simulation mode).

4.1 Launching the Simulator

Start the Simulator with the menu item Run > Start Simulator.

Fun | Format View Window Help

«a» Download To Target... ean M

ey

Manage Target...

r_
ko Start Simulator

Figure 37

At this point, the Simulator is running in the computer, similar to the way the server runs on a panel.

4.2 Stopping the Simulator

Run | Format View ‘Window Help

«a Download To Target.., ca ) | e s

Manage Target...

—
\5 Stop Simulator

Figure 38

To stop the Simulator, select the Run >Stop Simulator menu item. You can also exit the Simulator using the
close button of the Simulator or by using the Exit option from the Context Menu.

4.3Simulator Settings

The Simulator can be used with real protocols & PLCs (Ethernet or RS-232 based protocols) or with
simulated protocols.
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Figure 39

When we invoke the Simulator Settings button, a dialog showing the protocols used in the project will pop-
up. Users can select to use actual or simulated protocols by using the Use Simulation checkbox.

By default the Simulator uses simulated protocols defined in the Tag Editor Simulator column for each Tag
(see Figure 40). Unchecking flag Mode, the Simulator will communicate using real protocols with devices.

NOTE Some protocols, for example the Variables protocol, does not support communication with devices
(Win32) and, for these protocols, this option remains disabled. Usually all protocols based on ETH or RS-232
can be simulated in win32 platform or in general all protocols that do not require special hardware.

r.'g!?_:f? Simulator Settings ﬁw

PLC Settings

ProtocellD ProtocolMame Maode

1 protl (71, Use Simulation

2 prot? Variables Use Simulation

3 prot3 Variables Use Simulation

[ OK ][ Cancel

\ J
Figure 40
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When defining Tag values, the Tag Editor also includes a field Simulator to select a method for simulating
the data. Tag values can be simulated in the following ways:

Variables The data is stored in a variable in the simulator. This variable holds the
value of the Tag so the client can read and write to the Tag value.

SawTooth A count value is incremented from “Offset” to “Amplitude + Offset” value
with a “Period” of 60..3600 seconds. When the counter reaches
“Amplitude + Offset”, the value is reset to “Offset” and the counter
restarts.

Sine Wave A sine wave value is generated and written to the Tag value. The Min,
Max and Period values of the Sine wave can be defined for each Tag.

Triangle Wave A triangle wave value is generated and written to the Tag value. The
Min, Max and Period values of the wave can be defined for each Tag.

Square Wave A square wave value is generated and written to the Tag value. The Min,
Max and Period values of the Sine wave can be defined for each Tag.
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5 Transferring the Project to Target

The HMWIN Studio project can be transferred to the runtime in two ways:
1. Using the Download to Target item in the Run Menu.
2. using an Update Package via USB

5.1Download to Target

Run -> Download to Target can be used to transfer project and runtime via Ethernet from the HMWIN
Studio to the runtime.

NOTE The panel must have a valid IP address assigned. Please see the chapter “Unit Basic Settings” for
further information on how to assign an IP address to the panel.

Once the panel has a valid IP address assigned, it will become discoverable on the local network. Click on
the discovery button and select the HMI from the list of IP addresses.

Downlead to Target I&

Ready to download

192 ., 188 . 7 . 129

Download I l Cloze

HMI@192.168.4.210
HMI*@192.168.7.129 y.
Ldvanced...

Figure 41

Click on the Download button to start the process. The system will switch the Target to Configuration mode
and transfer the files. When the download operation is completed, the Target is automatically switched to
Operation mode and the downloaded project is started.

Any time a project is changed, the modified files needs to be transferred to the Target device. When
updating a Target, HMWIN Studio provides the option Download only changes to transfer only the modified
files to the device. The figure below shows the Advanced options expanded.
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Advanced
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[| Delete Dynamic Files (Recipe, Security-Users, Schedulers, Multlanguage)

L A

Figure 42

The other option is Delete Dynamic Files. There are files that can be modified in the HMI at runtime, for
example you can create new users at runtime or you can upload new values to the recipes. If the option to
delete the files is selected, the edited configuration of the recipes, or users, or the schedulers will be deleted
and overwritten by the project configuration.

NOTE Dynamic files are not deleted using Delete Dynamic Files if storage type is external (example USB /
SD Cards).

IMPORTANT Please make sure to check carefully before selecting this option as some data can be lost.
Data cannot be restored after it has been deleted.

When transferring a project, the Studio uses a combination of HTTP and FTP connection. The HTTP
connection is used to issue commands to the target device like “switch to transfer mode” or “unload running
project”; the FTP session is instead used to transfer the files to the panel flash memory.

The Default port for HTTP connections on the Target is set to 80. However, the user can change the port
number to a different value. To set the port number from HMWIN Studio, click on the Run > Manage Target,
and then click on Target Setup on the dialog. The HTTP, FTP port or HTTPS, FTPS port can be set for the
target.

The Host Name can be defined by the user, in the appropriate box in the Target Port pop-up. This will allow
each panel to be easily identified on a network with multiple panels. The drop down box will no longer show
HMI@10.2.0.6, but will show, for example, Machinel@10.2.0.6.

After renaming the host, it is necessary to download the system files to the target.
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Figure 43

NOTE Transferring a project after the above settings will result in a change of the default configuration. At

the next download, the new ports will be used on the target and the new ports will have to be specified in the
software to match the new selection.

In the download dialog, click on Advanced Menu and set the port.

Download System Files ﬁ

|TargetSetup... || Download ||  Close |

Figure 44
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Set the HTTP/HTTPS port and FTP/FTPS port of the Target. They represent the port numbers the software
uses to connect to the FTP(S) and the HTTP(S) servers on the Target. This is useful whenever default ports
are, for some reason, in use by other applications or services, or if the local network requires using different
port settings.

' 4
Studio Port Settings e |
HTTR:  ap HTTPS
FTP 21 FTPS

Availability |

Ok |I Cancel I

L -

Figure 45

When Target Flash Memory is Low

While trying to download a project to the Target, if the project size is almost near or greater than the free
space available in the flash memory, then it is not possible to download the project directly. The difference
between the project size and available free memory should be at least 2MB.

Target device doest not have enough free memory...
Do you want to delete some unloaded projects 7

Manage Target...J [ Cancel

Figure 46

While clicking Download, a warning message will pop up mentioning that the Target memory is low and
whether you need to delete some projects (as in the figure given above). Soon after you click “Manage
Target”, the Manage Target window will open showing all the available projects in the Target. Deleting the
unwanted projects from the target creates more memory space, hence making it possible to download the
current project. By pressing Cancel, the dialog will close, and the download operation is aborted.

NOTE The automatic check for available space for project download is a feature present from HMWIN
Studio and runtime version 1.80.

5.2Update Package

Both Runtime and project can be installed or updated using an update package via USB. To create an
update package proceed as follows:

1) From the Run menu in the top toolbar, select Update package

2) Select the target and components you need to update

3) Specify the output directory for update package (example. USB flash drive)
4) Click Create to generate package
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5) Assuming you have stored the package in the root folder of a USB drive, remove the drive from the PC,
plug it into the HMI, activate the context menu by holding your finger for a few seconds on the screen (see
also “Basic Unit Settings”) and select “Update...” as shown in the figure below.

Zoom In
Loom Ot
Zoom 100%

Pah mode

Settings...

Project Manager...
Lpdate, ..
Backup/Restare
Logaging

Show Log at Boot

Shiow systern settings

About,..

Figure 47

6) The system will automatically check for the presence of the update package in the root of the USB drive
and ask confirmation to proceed with the update according to the figure below.

HMI Update Wizard 1f2 0K

Flease wait, examining system...

Available updates: I YWISEMernory EI

Auto select best match

Components that wil be updated:

- Project Files
- Fant files
e Systermn Files

MNext Cancel

Figure 48

7) Mark the “Auto select best match” check box and click the “Next” button. The rest is automatically done by
the system.

IMPORTANT, It is always recommended to create update packages with both flags Project and HMI
Runtime checked. Use latest runtime with old project not converted with HMWIN Studio can originate
stability problems.
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Location :

HMI Runtime & Plug-In

[ set Target Password D

[ Encrypted

L]

Create ][ Cancel ]

Figure 49

Target

Project
HMI Runtime &

Plug-In

Set Target
Password

Encrypted

Location

Target type. When a project is open the target type is selected
automatically otherwise it is responsibility of the user to select the correct
target type.

Project opened in HMWIN Studio is added to the update package.

HMI Runtime is added to the update package. If a project is open in
HMWIN Studio, also required plugins will be added to update package.

Can be used to set password used by HMI Runtime to protect operations
like upload of projects, board management, download of projects, etc.
Ref. to Remote access protection to HMI Panels for more information on
to access protection.

Enable Encryption of update package; it cannot be read by any user and
can be unzipped only by the HMI Runtime.

Path for saving the update package.

5.3The Runtime Loader

The explanations provided in the previous chapters are valid when using a panel with the runtime system

already installed.

The HMI devices are delivered from the factory without the runtime. When you power up the unit for the first

time, it starts with the “Runtime Loader” screen as shown below.
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m System settings

Can)l Transfer from disk

No HMI found
Waiting for transfer

Figure 50

NOTE The Runtime Loader is a feature dependent on the device Operating System and may not be
available on all the units. The description provided in this chapter assumes that you are using HMWIN Studio
V1.80 or later. On MIPS based units, the Runtime Loader is available from version V2.65; on ARM based
units the Runtime Loader is supported from BSP version V1.52.

When you click on “System settings” you can activate the System menu in User mode, where you can set
the IP address of the panel. See the chapter “System settings tool” for additional information on this tool.

Once the IP address is assigned and the panel is connected to a valid network, the easiest way to install the
runtime is to download a project from the HMWIN Studio. See the chapter “Transferring the Project to
Target” for additional information.

The normal download procedure in Studio is able to recognize the need for transferring the runtime and the
process is automatically started. As soon as the panel IP is selected from the list of available units in the
network, Studio will recognize the need for transferring the runtime, providing the information as shown in the
following figure.

Downlecad to Target l—J

P

Target device does not have Runtime...
Do you want to install Runtirme 7
Ready to download

Install Runtime Cancel |

192 ., 188 . 7 . 129

B

|E| Advanced

L A

Figure 51

Just click on the Install runtime button to proceed.
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The process will automatically go through the required steps, ending with the project download.
On an off-the-shelf unit the runtime can be installed also using an USB pen drive.

Prepare the Update Package according to the instructions provided in the chapter “Transferring the Project
to Target* and make sure to mark all the check boxes for the HMI Runtime as shown in the following figure.

Then plug the USB drive in the panel and click on the “Transfer from disk” button.

m System settings

It Transfer from disk

Figure 52

Then follow then the instructions on the screen.
NOTE The Runtime Loader on the panel does not support the automatic installation of the runtime with

versions prior to 1.80; in case an older version of the runtime has to be used on a unit with the Runtime
loader, please contact technical support for additional information.

5.4Upload Projects

You can retrieve a project from a target device using the command “Upload Project”. A copy of the project is
transferred from runtime to the computer running HMWIN Studio.

To upload a project proceed as follows:

1. Run -> Manage Target
2. Intab “Runtime”, Select IP of the device from “Target” menu.

Target Mote
192,163.40. 258 B
winxp-clientl @192,168.42.30
Status:
HMIE192.168 .40.28
HMIZ192.168.41.1
HMIE192.168.42.20
HMIE192.168.41.171
HMI*@192.168 6.7
Advanced Settings
Figure 53
3. Click on “Retrieve Projects” to list all projects available in the target device
4. Select project to upload
5. Click on “Upload Project”
6. Enter password
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7. Upload process starts

Once upload has completed, a copy of project is available in: C:\Users\username\Documents\HMWIN
Studio\workspace\Uploaded\RuntimelPAddress\workspace\ProjectName

Starting from HMWIN Studio v1.90 (build 608) upload is no longer based on User Management for access
protection but is protected by a dedicated password scheme. Please refer to Remote access protection to
HMI Panels for more information related to access protection.

NOTE If upload operation failed please verify firewall settings of PC where HMWIN Studio is installed.

ACGMO195V1EN
HMWIN Studio User Manual 50



6 Programming Concepts

The programming guidelines for HMWIN Studio are based on a few basic concepts, which are common in
many parts of the system.

6.1 Attach to

In HMWIN Studio the basic programming techniques are used to configure the properties of an object placed
on a page. Object properties can be set at programming time or configured to be dynamic.

To change a property at programming time you can use the page toolbar or the property pane which shows
the properties available for the selected object.

@& ww v X oy v =

O % = Font [Aral *| 15 ~ B [

L

Figure 54

The page toolbar permits a quick change of the most commonly used object properties.

When you need a complete view of all the properties of a certain object, you need to use the property pane.
You have to select an object to see its properties shown in the property pane.

The property pane allows you to both change a property at programming time and attach the property to a
dynamic element.

From the property pane, when you click on the right side of a property cell, you get the ability to "Attach to"
the property to a tag. This operation is done using the "Attach to" dialog shown in the figure below.

Properties o X
& & &
- Field

Value 100 |T

Mumber H Attach To... |
Kevpad T¥re THUMErc
+ Ewvents

Figure 55

The “Attach to” dialog has two tabs. The first is called "Tag" and allows you to attach the property to an
element. The "source" can be selected using the radio buttons.

The elements to which the property can be attached are:

e Tags
e System Variables (see chapter System Variables for an explanation of the meaning of all System
Variables)

e properties from another Widget
e elements of a Recipe

The radio buttons at the bottom allow you to set the access type.
The Tagindex selection is used in the case of arrays to determine the array element.
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Figure 56

When adding Tags, the Protocols used in the Project are shown in the tag Dialog box and when expanding
each protocol, the corresponding tags can be seen. The tags will be arranged in alphabetical order inside
each Protocol.

There is an Option to search the tag to be attached by its name as shown in the Figure above.

This makes it easy to find Tags. The search can be done in two ways: first, you can start typing the tag name
in the left box and this will “jump” into the list to the first tag starting with the characters you have entered;
second, you can type in the search box any part of a tag name and this will automatically apply a filter to the
view so that only the tags which contain the search characters are displayed.

Scale/XForms allows you to apply transformations to the numeric value of the source element before it is
applied to the property of widget. Transformations can be simple linear relationships or generic
transformations.

Linear scaling can be configured when selecting the "Scale" tab and they can be specified in terms of a
formula or "By range". In case the range mode is selected, you just need to specify the input and output
range and the system will automatically calculate the factors for the formula.
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Figure 57

XForms transformations are applied to the result of scale transformation. Supported transformations are:

Color conversion Allows you to define a map between numeric values of the tag and
colors to be assigned to the property. This feature is used to change the
color of a button, for example, based on the value of a tag. If the tag is
an integer, you can have many different colors based on the tag value

Bit and Byte index  Allows extracting a single bit or byte content from a word depending on
the specified bit or byte number.

Example of transformation: scaling (100/10*value + 5 ), bytelndex(0), bitindex(1) , equivalent to:
bitindex ( bytelndex (100/10*value+5,0) , 1)

ACGMO195V1EN
HMWIN Studio User Manual 53



P e

field1.value

XForms
Bytelndex(0) el el

¥Forms Froperties

4 Color Conversion
ColorPaletteCustom
4 Math
BitIndex
Bytelndex

Bytelndex 0

oK ] [ Cancel

L &

Figure 58

6.2Events

In a HMWIN Studio application, Events are the way to trigger Actions at the application level.

Main types of Events:
e Events related to buttons / touch (Click, Press, Release, Release)
e Events related to external input devices like keyboards & mouse (Click, Press, Hold, Release,
Wheel)
Events related to data changes (OnDataUpdate)
Events related to switch of pages (OnActivate, OnDeactivate)
Events related to alarms
Events related to scheduler

Whenever the system generates an Event, you can attach one of the following actions to the event:
e an Action/Macro (or sequence of ) selected from a list of predefined actions
e aJavaScript function

The figure below shows an example of an Action activated by pressing a button.
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Click Type momentar
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OnMouseClick Action
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OnDatalUpdate Action
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OnMouseR Add Actions

+ Configure Add JavaScript

+ Text [

Figure 59

By associating Actions to Events, the programmer configures user interaction with the program.

6.2.1 OnClick / OnMouseClick

This Event occurs when the button/key is pressed and released quickly.

OnMouseClick ( OnClick)

A
I I
; | >
OnMousePress |
OnClick/
OnMouseRelease
Figure 60

6.2.2 OnHold / OnMouseHold

This Event occurs when the button/key is pressed and held pressed for a certain Hold time. Actions
programmed for this Event will be executed only after the Hold time has expired.

Default Hold time is configured in project properties but can be redefined for each button/key.
When a value -1 is specified as Hold time for a certain button, the project default value will be used.
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Figure 61

6.2.3 Autorepeat

It is possible to enable autorepeat for Press event or for Hold event of a button/key.

Autorepeat Time is specified in Project properties but can be redefined for each button/key.

OnMouseHold (OnHold) and Autorepeat

‘ Repeat Repeat
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OnMouseHold
Figure 62

OnMousePress and Autorepeat
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Figure 63
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6.2.4 OnWheel

This Event occurs when a wheel (example: a USB mouse wheel or a handheld wheel) value change. A
wheel usually is used to increment/decrement a value in data entry or attached to a tag.

6.2.5 OnActivate

This event triggers when a page is loaded and before widgets being initialized with the values read from Tag
Manager.

6.2.6 OnDataUpdate

This event triggers when a data field attached to a widget changes. Upon page change, data is updated
asynchronously at a time that depends on the time needed to read data from protocol. As a consequence,
the OnDataUpdate event can be triggered or not, depending on whether data becomes available from
protocol respectively after or before widgets being initialized for first time. In particular page change
notifications are more likely to happen with slow protocols and remote clients.

Moreover, note that the value we read during OnActivate can be the same we get from a subsequent
OnDataUpdate event, since OnDataUpdate notifications are sent asynchronously.

6.3Widgets positioning: Snap to Grid / Snap to Objects

To help user in precise widgets positioning two editing options options are available in HMWIN Studio:
- Snap to Grid
- Snap to Object

“Snap to” positioning can be enabled via the top toolbar ->View menu items.

6.3.1 Snap to Grid

In Snap to Grid mode when you move or resize an object, its top left corner will align or "snap to" the
nearest intersection of lines in the grid, even if the grid is not visible. If default settings does not fit your
needs, you can either switch off the function of customize the grid.

The Grid can be enabled from View ->Show Grid and customized from View->Properties where it is
possible to choose:

- Spacing X: space in pixel between two lines/dots in X axis

- Spacing Y: space in pixel between two lines/dots in Y axis

- Type: type of grid, dot or line

- Color: the color of grid

6.3.2 Snap to Object
In Snap to Object mode when you move an object, it will align or "snap to" other objects.
When you select an object to move, one of the following hot points is selected as the source of the snap

point, depending on the area you pressed: top, top left, top right, bottom, bottom left, bottom right, left, right,
center:
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Figure 64

The algorithm tries to find a matching hot point among the neighbourhood widgets hot points which matches
either x or y coordinates of the source snap point.

For line widget the source snap points are the terminal points of the line.

6.4Z-order of widgets

Z-order is an ordering of overlapping two-dimensional objects / widgets such as shapes (or objects in a 3D
application). One of the features of widgets is that they could overlap, so that one widget hides part or all of
another. When two widgets overlap, their z-order determines which one appears on top of the other.

A widget with greater z-order is always in front of an element with a lower z-order.

Z-ordering of widgets is essential for performances since overlapping dynamic widgets can invalidate static
optimization and reduce performance of hmi applications.

In HMWIN Studio a new toolbar is available to help user understand widgets overlapping. The toolbar allows
to:
- Enable visual filtering: hide widgets stacked above and/or below selected widgets (using the two
buttons available in toolbar).
- Check z-order of widgets using the combobox. An icon allows to distinguish between static (picture
icon) and dynamic (movie frame icon) widgets. The combobox is listing widgets in z-order.

Visual filtering reduces the opacity of the widget above the currently selected widget, so user can easily edit
widgets hidden by overlapping items.

;] = E #6 drop F]
E #lrectl

E #2rect2
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Figure 65
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6.5Change properties of several widgets at once

For widgets of the same type (ex. two or more labels, two or more fields, two or more gauges etc) the user
can change common properties in few steps using HMWIN Studio.

To change multiple properties of widgets proceed as follow:
1) Select all widgets of the same type where is required to change common properties
2) Change common properties from property pane

When multiple widgets are selected, the property pane title changes to “<MultipleObjects>" indicating that
all properties changes will be applied to all widgets selected on the page.

Properties o x
&1 &8 &

-| <MultipleObjects=> -
Value 99999
Mumber Forma g
Keypad Numeric
Min -32768
Max 32767

Figure 66

NOTE Not all properties can be modified for multiple widgets simultaneously and must therefore be
modified individually.
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7 Project Properties / Project Widget

Project properties contain settings for the project. Project properties are available from Project View.
The Properties window on right side of the HMWIN Studio contains the list of project level user-configurable
data.
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! File Edit Run Format View Window Help
SRR R IR RS SOMNSECORH R
;.:J' ProjectView a x L:Project223 x| 1:Pagel w Properties o x m
o + —L£ AV @ & 'g-
% | 2.8 Project223 ﬁ - o Project Widget nE
§ Bg E;oject properties _PageMgr -Harabletiat d ijECtZZ?' :%
/@ Templates Context Menu on delay
- Config Developer Tools false
----- £\ Protocols Keyboard true
---- =] Tags JavaScript Debug falsa
E Trends Allow Javascript Remote Del false
ng Reports
_____ & Alarms Image DB Enable true
----- Events Buffer Plugins =
I Scheduler = Behavior
----- % MultiLanguage Home Page Pagel.jmx
-9 Screen Saver PageWidth 800
EE Data transfers PageHeight 600
AL T
e Dy Hode Landscape
I/ Recipes Project Type eTOPS10
F'_ﬁ Dictionaries PageRequest
-7 Keypads CurrentPage
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Autorepeat Time (ms) 250 u
Events =
Project Widget '
Ready I8l | |k
——————————————————————————
Figure 67
7.1Version

The Version field is available for users to report the project version.

7.2Context Menu

The default method for users to access the runtime settings is to press and hold for a few seconds on an
empty area of the runtime screen. Using this property you can choose how the context menu should appear:
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Figure 68

7.3Developer Tools

Developer tools are a collection of utilities useful for debugging problems at runtime. To use developer tools
proceed as follow:

1) setto true Project properties ->Developer tools in HMWIN Studio
2) Download the project to the target

3) Open context menu

4) Select Developer tools

F0lda-04-F & S o idle: 24 %

Thread
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Code=yre=
Other threads=
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ImageDE
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Figure 69

The list of items available in developer tools is reported below.

Show/Hide all Show an overview of all main information about device
status like CPU Load, memory usage, event queues etc.
in one dialog in overlay.
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Cpu statistics Show information about CPU load. On top the actual
machine time is shown along with the total machine
uptime. CPU statistics are collected with a frequency of
2000 milliseconds. The actual period time and the
overhead required to collect and visualize statistics are
displayed as well. The more the actual period time is far
from the nominal 2000 milliseconds the more the system
is busy. Cpu consumption of threads of is listed reporting
the name of the thread (if available, main thread is marked
with a *), the thread ID, the thread priority and cpu time
spent during the 2sec period, divided in user and kernel
time.

Memory statistics Show information about CPU load. In particular the free
system RAM is shown along with the difference of
memory usage from previous iteration (a negative value
means free memory is decreasing).

Event queues Show information about the size of event queues. Many
core components of the HMI are event driven. For each
event queue the actual size of the queue, the maximum
achieved size of the queue, the total number of events
processed and the last and maximum times required to
process events are shown respectively (timing statistics
are only available for non-Ul queues).

Timelog summary Show information about time spent for loading active
page. See 7.3.1 for more details.

Embed window Allows to embed in runtime the scene or leave the
developer tool window as a standalone window (dialog).

Reset queue stats Reset information collected related to event queues.

Disable watchdog Disable the watchdog and avoid system restart in case of
freeze or crash of services

Ignore exceptions Usually when an exception is captured the crash report
panel is shown. By setting this option exceptions will be
ignored and no crash report window appears.

Launch VNC Launch VNC server if available in runtime. VNC server is
available as a plugin for WCE target only.

Using this option it is possible to check the time spent for

Profiling loading/rendering the active page.

7.3.1 Profiling

Using this option of the developer tools, it is possible to check time spent for loading/rendering the active
page. Profiling will be available from the next page load and only for the first painting of the page to the
screen (please note that the configuration is retained).
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Figure 70

Profiling data can be:

7.3.2

saved to file (Save timelog to file): save a .txt report of time spent loading project & pages. Usually
is better to avoid it since it could have high and unpredictable effects on page change performance.
However it's useful to export & share profiling details.

visualized using context menu (Timelog summary): a summary about current page (and related
template if any). There you can see partial times for different operations. Usually the most important
ones are:
o Time parsing: time spent for parsing current page file / .jmx. Parsing time usually is
proportional to the number of widgets in a page (so to the complexity of a page).
o Time gfx creation: which is mainly contributed by the OnLoad methods, where typically
images are loaded.
o Time rendering: time spent for rendering the scene
o Time unloading: time spent for unloading page(in case the current page comes from
another page).

Times are provided in couples: wall time/cpu time. Wall time is the absolute time required by this
part which can be higher than the actual cpu time used to do it because we can have higher
priority threads running (for instance protocols). There is also a start time column which is
relative to page load start time. It can be useful to track the actual time required to load a page,
since partial ones only focus on the most time critical functions missing the rest that often
contributes significantly to the total time. For example the actual total wall time required to load a
page is rendering (which is the last step) start time + rendering wall time.

overlayed as colored rectangles on the view (Overlay OnLoad/Rendering times):this view allows to
effectively represent time spent on single widgets and is available only for the rendering and OnLoad
steps. The view gives an immediate feeling of where time is spent. Red zones represent the most
time critical zones. Detailed widget times are visualized by a tooltip window (on Win32 platform
attached to mouse hover event, on WCE press drag and release over the region of interest). In case
of out-of-the-scene widgets some arrows allow to navigate to these areas and hovering on them the
tooltip will show the area summary.

Watchdog

One of the most important items in the Developer tools is related to the watchdog. This item allows the
developer to disable the watchdog to avoid a system restart in case of a runtime crash, to have time to save
the crash report or check system status information (example: memory available, CPU load, events queue
size etc).
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Crash report dialog appears automatically in case of a system freeze or crash and allows users to save a
log file of crash. The crash report may contain information important for technical support.

HMIServer has stopped working.

Save | Restart || Cancel I

HMIServer 1.90 (0] - Build (361) un3l 2013-09-03 nz:l_:
fres——

In thread Codesys at address 0x4l711c3&: access violation
FaM free 1408655336 F 1973730604 Bytes

«| N

[«

Figure 71

7.4Buzzer on touch / Buzzer duration

Using this feature the runtime buzzes when a user presses one of the following widgets:
- Buttons
- HotSpots
- Needles
- Fields
- External keys
- Combobox
- Tables items
- Control list items

Using Project properties ->Buzzer duration defines the duration of the buzz when an event is fired. Buzzer
duration is a value in ms, default is 200ms.

NOTE Buzzer on touch requires WCE v1.76 ARM / 2.79 MIPS and can be used as an alternative to the
Touch buzzer feature available WCE side that buzz when user touch any point into the touchscreen.
Buzzer on touch is supported also by Win32 runtime.

7.5Keyboard

Enable the use of keyboard Macros at runtime when using external keyboards.

7.6JavaScript Debug
Enable the JavaScript debugger at runtime for current project.

NOTE For UN20 target (WCE MIPS hmi panels), local debugger has been disabled. However, remote
debugger is available to debug JS from a PC connected to HMI panel via Ethernet.

NOTE Remote debugger not supported in HMWIN Client and ActiveX.
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7.7Allow JS Remote Debugger
Enable the JavaScript remote debugger for current project.

NOTE For UN20 target (WCE MIPS hmi panels), local debugger has been disabled. However, remote
debugger is available to debug JS from a PC connected to HMI panel via Ethernet.

NOTE Remote debugger not supported in HMWIN Client and ActiveX.

7.8lmage DB enable

Enabled by default, this property activates an engine used by the runtime to optimize project performance.
Available in the Project Properties, should be disabled just by tech support for debugging in case of a
problem. Disabling it can create performance problems at runtime.

7.9FreeType Font Rendering

The “FreeType Font Rendering” property is used to switch between old font engine used by HMWIN Studio
& Runtime up to v1.80 (native OS-based font engine) and the font rendering based on FreeType.

All projects created with HMWIN Studio v1.90 (b608) or newer use the FreeType font engine as default while
all projects created with older versions of HMWIN Studio continue to use old font engine after the
conversion to avoid potential backward compatibility issues in font rendering.

Moving to the FreeType Font Rendering is recommended to all users; to enable it set true in “FreeType Font
Rendering” in Project Properties, save and verify that all texts are shown correctly in all HMI project pages.

Example of rendering issues that could appear when switching between old and new font engine are:
o text require few more/less pixels for rendering and this could change text layout
e size to fit could result in change in size of widgets.
e Dbetter rendering using antialiasing (feature not available in v1.80). Antialiasing can be disabled in
v1.90 for texts (it is a property of text widgets).

7.10Software Plug-in Modules

The Software Plug-in concept allows users to choose if certain software modules must be downloaded to the
runtime together with the project. Example of Software Plug-in are:

WebKit (module required by browser widget — if available).
PDF Reader

VNC Server

ActiveX

Not all Software Plug-in modules are compatible with all targets. New software plug-in modules will be added
in the future to extend optional features of the product.

Once enabled, a Software Plug-in is considered as part of the runtime. You can use HMWIN Studio to install
it in the target using one of the following procedures:

e Installing runtime / Updating runtime

e Update Package

Plug-ins can be removed once installed using one of the following operations from System Mode:
e Format Flash
e Restore Factory Settings
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The system is not able to detect automatically if any Software Plug-in is required by the HMI application, so it
is up to the user to select the Software Plug-in manually from the project properties when required.

Software Plug-in support has been designed for embedded HMI panels where storage is limited and
reducing software footprint is critical. This option is not supported in Win32 platform.

7.11Behaviour -> Home Page

Define Homepage of project. The homepage is the first page loaded at runtime (after log-in page if security is
enabled in project).

When Security is enabled, it is possible to specify a different homepage for each groups of users, in this
case this property is ignored. Refer to User Management for more details.

7.11.1 Behavior -> Page Width / Page Height

Define default size in pixel of an HMI page. Default is target type dependent (depend on HMI panel screen
resolution).

7.11.2 Behavior -> Display Mode

Define HMI panel orientation, Landscape or Portrait.

7.11.3 Behavior -> Project Type

Define target type / HMI panel model. Based on model, many features and properties of project are
automatically adjusted to fit it in the right way.

7.11.4 Behavior -> PageRequest, CurrentPage and SyncOptions

The HMI projects contain properties that let you know which page is currently displayed on the HMI and to
force the HMI to switch to a specific page. These properties can be used to synchronize pages showed on
the HMI and HMWIN Client or to control an HMI with a PLC.

Double click on project name present into ProjectView pane to open the project properties page:
RN NS N N WERN: N[N Ky HoY

1, Projectiiew a = 1:F‘agel/ 1:MyProject x]

+ =11

= My Project Ry a=

: Langl -
: 7

@ — _ariablesigt
= Pages _PageMar
S 1 Pagel
=¥ Canfig
) Protocols
_'_| Tags
B Trends
A Alarms
i Events Buffer
T scheduler
';’:,.‘- MulkiLanguage

anainjaalyo &
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Figure 72

Expand the properties view of the Properties pane, by clicking on "Show Advanced Properties" button:

Froperties a
&1 &H &
- Project Widget
1d MyProject
Full Path C:\Documents and Settingsia
Version
Conkext Menu on delay
Image DB Enable | true
= Behaviar
Haome Page Pagel.jmx
Pagetidth 800
PageHeight 480
Display Mode | Landscape
Project Tvpe
= PageRequest
Datalink PageRequest_tag: _TagMgr
- CurrentPage
Diakalink CurrentPage_tag:_TagMagr

Syncoptions local+remote
Figure 73

Following properties, highlighted in green in the picture above, can be configured:

PageRequest This property determines the page to be shown on the HMI and on
HMWIN Client.
Attached Tag must contain an integer value within the range of the
available project pages.
The attached Tag must be available at least as a Read resource.

CurrentPage This property represents the page number actually displayed on the HMI
or on HMWIN Client or on both.
Attached Tag must be available at least as a Write resource and must
have data type that allows containing an integer value.

SyncOptions value can be set as one of following options:
e Local: if you want that CurrentPage represents the number of
page actually displayed on HMI,
e Remote: if you want that CurrentPage represents the number of
page actually displayed on HMWIN Client.

SyncOptions This property determines the synchronization of the project pages with
the value contained into the CurrentPage property.

e Disable: CurrentPage value is ignored.

e Local: CurrentPage value corresponds to the page displayed on
HMIL.

e Remote: CurrentPage value corresponds to the page displayed
on HMWIN Client.

e Local + Remote: CurrentPage is changed according to page
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displayed on HMI and on HMWIN Client, if different pages are
displayed; CurrentPage refers to the last page loaded.

Examples related to the use of PageRequest and CurrentPage.

Example 1

Force page change from PLC to HMI and HMWIN Client.
PageRequest attached to Tag "A"

CurrentPage Empty

SyncOptions Disabled

Changing value of "A", HMI and HMWIN Client will show page requested.

Example 2
Force page change from PLC to HMI and HMWIN Client. Read current page loaded on HMI.

PageRequest attached to Tag "A"
CurrentPage attached to a Tag "B" as Read/Write
SyncOptions Local

Changing value of "A", HMI and HMWIN Client will show page requested. On "B" will be written page
currently showed by HMI.

Example 3
Force page change from PLC to HMI and HMWIN Client. Read current page loaded on HMWIN Client.

PageRequest attached to Tag "A"
CurrentPage attached to a Tag "B" as Read/Write
SyncOptions Remote

Changing value of "A", HMI and HMWIN Client will show page requested.
On "B" will be written page currently showed by HMWIN Client.

Example 4
Force page change from PLC to HMI and HMWIN Client. HMWIN Client page Synchronization with HMI (not
vice versa) .

PageRequest attached to a Tag "A" as Read/Write

CurrentPage attached to the same Tag "A" as per PageRequest
SyncOptions Local
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Changing value of "A", HMI and HMWIN Client will show page requested. Changing page on HMI same
page will be forced on HMWIN Client.

Example 5
Force page change from PLC to HMI and HMWIN Client. HMI page Synchronization with HMWIN Client (not
vice-versa).

PageRequest attached to a Tag "A" as Read/Write
CurrentPage attached to the same Tag "A" as per PageRequest
SyncOptions Remote

Changing value of "A", HMI and HMWIN Client will show page requested. Changing page on HMWIN Client
same page will be forced on HMI.

Example 6
Synchronize displayed page between HMI and on HMWIN Client.

PageRequest attached to a Tag "A" as Read/Write
CurrentPage attached to the same Tag "A" as per PageRequest
SyncOptions Local+Remote

Changing page on HMI, same page will be shown on HMWIN Client and vice-versa.

7.11.5 Behavior -> Hold Time / Autorepeat Time

Define default values for hold time and autorepeat time for buttons and external keyboards. However, for
each button/key, they can be redefined in related widget instance.

7.11.6 Events -> OnWheel

A wheel is used by special products like handhelds or USB mouse with a wheel input device. Usually a
wheel is used to increase/decrease the value of a Tag without the need to use an external keyboard device.

From Project Widget it is possible to attach to a change of wheel status an action like StepTag to
increase/decrease a tag value.
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8 System Variables

System variables are special tags containing information about the runtime.
System variables are available in the Attach to dialog from the "Source” selection as shown in figure.

’
field1L.value

Tag | Scale | ¥Forms

Source:

(7) Tag @ System () Widget ) Redpe

Tag:

Alarms -
Communication

Daylight Saving Time

Device

Dump Information

Monitor and DVI Switch Settings
Metwork

PLC

Printing

5D Card -

m

e R v R v v A A A

@ Read Only () Read/Write () Write Only TagIndex: |0 :

Figure 74

System variables are divided into categories.

Starting from v1.90 (b608), System Variables are available also as a standard protocol in the Protocol Editor.
This protocol can be used for data transfer betweens System Variables and tags from devices, or when is
necessary to specify a custom refresh rate for a System Variable.

8.1 Alarms

Variables return information on the actual number of alarms according to the status.
Not Triggered Total number of alarms “Not Triggered Acknowledged”
Acknowledged

Not Triggered Not  Total number of alarms “Not Triggered Not Acknowledged”
Acknowledged
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Triggered Total number of alarms “Triggered Acknowledged”
Acknowledged

”

Triggered Not Total number of alarms “Triggered Not Acknowledged
Acknowledged

Triggered Alarms Total number of alarms “Triggered”

Number of missed  Total number of missed alarm events
alarm events

All these System Variables are Int type (32 bit), read only.

8.2Communication

Variables return information on the status of the communication between the HMI device and the controllers
configured in the Protocol Editor.

Protocol The variable is read only Int (32 bit), and can have 3 values:
Communication 0 = No protocol running; it may occur if the protocol driver has not been
Status properly downloaded to the target system.
1 = Protocol has been properly loaded and started; no communication
errors

2 = At least one communication protocol is reporting an error

Protocol Error This variable returns an ASCII string containing a description of the
Message actual communication error. The communication protocol acronym is
reported between square brackets to recognize the source of the error in
case of multiple protocol configurations.
The variable is a read only string. If no errors are present, the string will

be blank.
Protocol Error This variable returns the number of communication errors that occurred
Count since the last time it was reset.

The variable is a read only integer. The reset of this variable is only
possible using the dedicated Action “Reset Protocol Error Count*

8.3Daylight Saving Time

Variables return information on the system clock and allow adjusting it from the application. They contain
information on the "local" time.

All the variables are read only; this means that you cannot change them to update the system RTC. All the
variables are bytes (8 bit) except for the DLS and Standard Offset that are shorts (16 bit).

Standard time is the "solar time" and other is Daylight Savings Time.

Standard offset Represents the offset in minutes when standard time is set, with respect
to GMT. (with respect to the picture it is -8*60 = - 480 minutes)

Standard week the week in which the Standard time starts (w.r.t. the picture it is First =
1)

Standard Month the month in which the standard time starts (range of the variable is [O -
11] so w.r.t. the picture it is November = 10)

Standard Day day of week in which the standard time starts (w.r.t. the picture it is
Sunday = 0)
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Standard hour hour in which the standard time starts (w.r.t. the picture in Time field it is

02=2)
Standard minute minute in which the standard time starts (w.r.t. the picture in Time field it
is 00 = 0)
Dst offset Represents the offset in minutes when DLS time is set, with respect to
GMT. (w.r.t. the picture it is -7*60 = - 420 minutes)
Dst week Week in which the DLS time starts (w.r.t. the picture it is Second = 2).
Dst Month month in which the DLS time starts (range of the variable is [0 -11] so
w.r.t. the picture it is March = 2)
Dst Day day of week in which the DLS time starts (w.r.t. the picture it is Sunday =
0)
Dst hour hour in which the DLS time starts (w.r.t. the picture in Time field it is 02 =
2)
Dst minute minute in which the DLS time starts (w.r.t. the picture in Time field it is 00
= 0)
Parameters for Day Light Saving Settings
STANDARD TIME
START (IN UTC)
Offset Week Day Month Time
-08:00 First || Sun |+ of Nov [=]  |02:00

Daylight Saving Time {Summer Time)

STANDARD TIME
START |IN UTC)

Offset Week Day Month Time
-07:00 Second || Sun || of Mar [+|  02:00

CURRENTLY SET
Standard Time |E|

Figure 75

8.4Device

Variables can be used to adjust specific device settings and obtain operational information.

Available System Returns the free available RAM memory in bytes; it is a 64 bit data; it is a
Memory read only variable.

Backlight Time Returns the activation time in hours of the display backlight lamp since
production of the unit; it is a read only variable.
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Battery LED

Battery Timeout

Display Brightness

External Timeout

Flash Free Space

System Font List

System Mode

System UpTime

Touch Buzzer,
Buzzer Setup,
Buzzer Control,
Buzzer Off Time,
Buzzer On Time

ACGMO195V1EN

Enable/Disable the use of the front LED indicator to report the low
battery status. It can have values 0 (disabled) or 1 (enabled).

Reserved

This variable is an integer of R/W type. Its range goes from 0 to 255. It
can be used to check brightness level and adjust it from the application.
Typical use is connected to a slider widget.

When set to a low level (0..3), the backlight assume a low but visible
value for around 8 seconds (to let the user change it otherwise nothing is
visible on the display) and after that display appears as switched-off.
However, even with a value of 0, the backlight is still on and the counter
of backlight life time continues to increase.

Allows setting the non-operational time after which the display backlight
is automatically turned off. The backlight is automatically turned back on
when the user presses on the touchscreen.

The variable is an int of R/W type.

-1 = switch off backlight and disable touch (switch display off). Backlight
counter is stopped.

0 = switch backlight on (so switch display on)

1..n = set a timeout for switch off backlight, so work like a screensaver
timer

Returns the free space left in the device internal flash.

List of system fonts. The variable is a read only string.

Returns a value informing the operation status of the runtime. Possible
values are:

Booting

Configuration mode

Operating mode

Restart

Shutdown

agrLONE

Returns the total time in hours in which the system has been powered
since production of the unit. It is a read only variable.

Touch Buzzer: allows enable/disable the touch audible feedback. It can
have values 0 (disabled) or 1 (enabled).

Starting from BSP 1.66.6 ARM / 2.73.1 MIPS, buzzer control has been
extended as below:

Buzzer Setup (replace Touch Buzzer System Variable)

0: disabled, no buzzer sound under any condition.

1: enabled, buzzer sounds as audible on any touchscreen event.
2: buzzer status controlled by System Variable "Buzzer Control"

Buzzer Control

0: Buzzer off

1: Buzzer on

2: Buzzer blink (on and off times programmed by System Variables
Buzzer On and Off)

Buzzer Off Time

duration in milliseconds of off time when blink has been selected
minimum value: 100

maximum value: 5000

default value: 1000
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Buzzer On Time

duration in milliseconds of on time when blink has been selected
minimum value: 100

maximum value: 5000

default value: 1000

8.5Dump Information

Variables return information about the status of the copy process to external drives (USB or SD Card) for
trend and archive buffers

Dump Trend Returns value 1 during the copy process of the trend buffers. If the copy

Status duration time is less than one second, the system variable does not
change its value.

Dump Archive Returns value 1 during the copy process of the archive buffers. If the

Status copy duration time is less than one second, the system variable does not

change its value.

8.6Keypad

Variables return information about the status of the keypads.

Is keypad open Returns value 1 if a keypad is open, 0 if no keypads are open.

8.7 Network

Variables allow you to show network device parameters. The network system variables are all strings in
Read Only.

Gateway Gateway address of the main Ethernet interface of device

IP Address IP address of the main Ethernet interface of device

Mac ID MAC ID of the main Ethernet interface of device

Subnet Mask Subnet Mask of the main Ethernet interface of device
8.8PLC

Variables return informations about the status of CODESYS 2.3 integrated in HMI panels.

PLC Status Status of Integrated Codesys 2.3.
0=RUN
1=STOP

2 = RELOAD_FROM_FILE
3 = RESET_WARM
4 = RESET_COLD

ACGMO195V1EN
HMWIN Studio User Manual 74



Get
CopyCodesysProje
ct Action Status

8.9Printing

5=RESET_HARD
This is a read only system variable.

Status of CopyCodesysProject Action related to intergated Codesys 2.3.
0 = ACTION_NOT_CALLED

1 = ACTION_IN_PROGRESS

2 = ACTION_COMPLETED

3 = ACTION_ABORTED_CHK_FILE_MISSING

4 = ACTION_ABORTED_PRG_FILE_MISSING

5 = ACTION_ABORTED_SDB_FILE_MISSING

6 = ACTION_ABORTED_MUTIPLE_CHK_FILES_FOUND

7 = ACTION_ABORTED_MUTIPLE_PRG_FILES _FOUND

8 = ACTION_ABORTED_MUTIPLE_SDB_FILES_FOUND

= ACTION_ABORTED_INCONSISTENT_FILE_NAMES

10 = ACTION_ABORTED_UNABLE_TOMAKE_TARGET_DIR

11 = ACTION_ABORTED_COPY_FAILED

12 = ACTION_ABORTED_CODESYS_MODULE_NOT_PRESENT
This is a read only system variable.

[(e]

Variables return information about the printing functions. All the variables are read only.

In the table below you can read the description of the available system variables.

Completion
percentage

Current disk usage
Current job
Current RAM
usage

Disk quota
Graphic job queue
size

RAM quota

Status

Text job queue
size

8.10Screen

The percentage of competition of the current print job. It ranges from 0 to
100.

The size (in bytes) of folder where PDF reports are stored (it is
reportspool if option Spool media type is Flash).

The name of the report the job is processing. Current job is the following:
- [report name] for a Graphic Report
- [first line of text] for a Text Report

The size (in bytes) of the RAM used to process the current job.

The maximum size (in bytes) of the folder where PDF reports are stored.
The number of the available graphic jobs in the printing queue.

The maximum size (in bytes) of the RAM used to generate reports.

A string representing the status of the printing system. The possible

values are idle, error, paused and printing.

The number of the available text jobs in the printing queue.

Variables return information on the screen status.

Time remaining to
unlock
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Return time remaining to unlock screen (ref. LockScreen action)
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X Screen It shows the x screen resolution of the display
resolution

Y Screen It shows the y screen resolution of the display
resolution

8.11SD Card

Variables return information on the external SD Card plugged into the panel. They are 64 bit variables,
except the drive name which is a string. All the variables are read only.

SD Card Size in bytes of the available space.
FreeSpace
SD Card Name Name of the SD card.
SD Card Size Size in bytes of the card plugged in the slot.
SD Card Status Status of the SD card.

8.12Server

Variables return information on the Server status. All following system variables refer to server, not to client
(ex. HMWIN Client).

Current page Return the name of current page.

Current project Return the name of current project.

Operating mode It shows the number of seconds elapsed after the last display start in
time operating mode.

Project load time It shows the date time string in milliseconds, like the System Date

format, when the project was loaded in runtime

8.13Time

Variables return information on the System Time expressed in UTC format.
They are all Int (32 bits) of read/write type, except for the System time which is a 64 bit variable, still of
read/write type. This is actually the UTC time which also is available as date/time from the other variables.

Day Of Month Day of the month (1..31)

Day of Week Day of the week (0=Sunday, .. , 6=Saturday)
Hour Hour (0..23)

Minute Minute (0..59)
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Month Current month (1..12)

Second Second (0..59)
System Time System time
Year Current Year

8.14USB Drive

Variables return information on the external USB drive connected to the panel; they are 64 bit variables,
except the drive name which is a string. All the variables are read only.

USB Drive free space Size in bytes of the available space

USB Drive Name Name of the USB device

USB Drive Size Size in bytes of the device plugged in the USB port
USB Drive Status Status of the USB device

8.15User Management

Variables return information on users and groups.

No of Remote-Clients Alive Number of HMWIN Client connected to the server.
This is a read only short (16 bit).

This Client Group-Name Name of the group to which the current logged user belongs to.
This is a read only string.

This Client ID The variable is valid with reference to the HMWIN Client scope. Local
and remote clients connected to the same "server" (same runtime)
get a unique ID returned by this variable.

This is a read only short (16 bit).

This Client User-Name Name of the user logged to the Client where the system variable is
displayed
This is a read only string.

8.16Version

Variables return information on OS & Runtime version.

Main OS Version Return the version of Main OS. Ex. UN30HSxx60M0166
Runtime Version Return the version of runtime. Ex. 1.90 (0) — Build (682)
ACGMO195V1EN
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9 Actions

Actions are the function used to interact with the system; they are normally executed when events are
triggered.

When considering events generated by buttons (pressed or released) not all the actions are available for
both states. In case the selected action is not supported for the actual state, the software will report a
warning message as shown in the following figure.

’ =

This acticn is not allowed OnMousePress event, please configure
OnMouseRelease event,

L A

Figure 76

9.1Widget Actions

The following chapters will include the description of a set of actions dedicated to handling widget visibility
and control.

9.1.1 ShowWidget

The ShowWidget macro allows you to show or hide the page widgets. In the macro properties, select the
widget you want to show or hide, then set the show properties as follows: false to hide and true to show
widget.

Macro | Script

Widget Actions

- ShowWidget - ShowWidget
- TriggerlPCamera

- SlideWidget Widget |—
 Fefreshvert Sh  Select Widget %
Keyboard Actions

- Sendkey

- SendKeyWidget
age Actions

- LoadPage

- HomePage

- PrevPage

- Mext Page
- Last\istedPaos i

Macro Properties

13

[.m

-n

Widget
ShowWidgetAction widgetname

Figure 77
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9.1.2 TriggerlPCamera

The TriggerlPCamera macro allows you to start the image capture from an IP Camera. Select the IP Camera
Widget in the Macro Properties to trigger the capture from the IP Camera.

Macro | Script

Macro Properties

»

P TriggerlP Camera

- SlideWidget

. RefreshEvert
Keyboard Actions

= TriggerIPCamera

watMarne ipcameral

[atm |

‘.- SendKeyWidget
MultiLang Actions

L Set Language
Tag Actions

- DataTransfer wgthName

- ToggleBit Set the Widget name

Figure 78

9.1.3 SlideWidget

The SlideWidget macro allows you to show the sliding effect of a Widget, or of a Widget group, in HMI
Runtime.

NOTE The widget or grouped widget can actually be outside of the page in the project and slide in and out
of view.

Macro | Script
Widget Actions +  Macro Properties
-~ ShowWidget | [= slide widget
- TriggerlPCamera :
L Widget
- RefreshEvent Direction Horizontal
Keyboard Actions | Speed fast
- SendKey .
- SendKeyWidgst X Ditance 0
Page Actions % Distance (1]
-~ LoadPage Image Widget
E;T‘;:ZEE ToagleVisbiity true
- Mext Page Slide Lirnit false
- LastVistedFage ¥ Limit 0
- ShowDialog ¥ Limit P
- CloseDialog
- ShowMessage
- LaunchApplication
- LaunchBrowser
Tag Actions
- DataTransfer =
ACGMO195V1EN
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Figure 79

Widget
The Widget to slide

Direction
Sliding Direction

Speed
The transition speed of the sliding Widget

X Distance
The travel distance of the X coordinate of Pixel

Y Distance
The travel distance of the Y coordinate of Pixel

Slide Limit

Enable/Disable limiting the movement with Respect to the Coordinates (X and Y) of the Widget.

X Limit

When specified, automatically stops the slide action when the widget reaches the specified position.
Y Limit

When specified, automatically stops the slide action when the widget reaches the specified position.

Toggle Visibility
Toggle the Visibility of the Widget at the end of each Slide action.

Image Widget

Allows an image to show during the movement; the specified image will be shown during the Slide Operation
between the start and end point of the movement.

9.1.4 RefreshEvent

The RefreshEvent macro allows you to refresh the selected Event Widget. The Event Widget is a component
of the Alarm History Widget (see paragraph Alarms History Widget.).
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Action List - L
M
g
Action List = == /M %

#" RefreshE vent() Macro | Script

Widget Actions +  Macro Properties
-~ ShowWidget - RefreshEvent
- Trigger|PCamera =
i Event Mame | EventBufferWgtl

Page Actions
- LoadPage
- HomePage
- PrevPage
- NextPage

- LastVistedPage Event Name

. ShowDialog Set the Widget name
- CloseDialog

- ShowMessage

(] 3 ] [ Cancel

e

Figure 80

9.1.5 ContextMenu

Context menu is used to configure runtime parameters like Zoom level, to update runtime & project using an
update package, to show the log window, to access the rotating menu for basic HMI configurations like IP
Address or device local time etc. By default the context menu appears when the user press/click and hold for
few seconds in the runtime area (in an area free of widgets like buttons). However, in the project area, it is
possible to disable the OnHold event and configure the HMI to open the context menu just when the macro
ContextMenu is called by the user. Usually this macro is attached to a button and protected to be used just
by system administrators.

-| Project Widget
Id
Full Path
Version

Context Menu [ﬂ-ﬂ MRCro command ¥
Developer Tod on dela

Figure 81

9.1.6 ReplaceMedia

ReplaceMedia macro is used at runtime to replace/update existing Media files of a project with new files
provided via USB/SD or any other external device. Usually this macro is used to update project Images,
Video or Music.
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Following parameters are available:

- MediaType: Image, Video or Music. Define type of files to update.

- Device: define storage where runtime will search new media files (ex. \USBMemory).

- sourcePath: define folder where runtime will search new media files (ex. images).

- Image Resize: if enabled, the macro will resize images to the size of images at runtime. This is
applicable for image media type only.

- Silent: if enabled, will execute replace media macro without user interaction. Otherwise a dialog will
appear to allow user to select MediaType & storage where new media files are located (USB stick,
SD Card etc).

3" Select Device Type Iﬁ 4" Select Media Type ﬁ
@ UsB 1 5D ) Local ~1 Folder
= ¥ O E Il
S IS =) = ]
sourcePath: | \USBMemony\new Pictures E] Image e He
MNext= ] [ Cancel ] <Back ] [ Update l [ Cancel
Figure 82

ReplaceMedia Macro is working in WCE and Win32 OS. When ReplaceMedia is executed in remote using
HMWIN Client or via ActiveX, files are searched on HMI local storages.

ReplaceMedia macro for Video & Music has been design to work in combination with MediaPlayer widget.
ReplaceMedia macro for Images has been design to replace project images.

Follow API Javascript for replaceMedia method:

void replaceMedia(var sourcePath, var bSilent, var Device, var nMediaType, var bResize)
project.replaceMedia("Images"”, true, "\USBMemory", 1, true);

9.2Media Actions

The Media Actions macros have been created to interact with the Media Player widget at Runtime.
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Macro | Script

.. Fomward ~  Macro Properties

Media Actions
- PlayMedia

- StopMedia |E|

- Reload Media

- PauseMedia

- BrowseMedia

Keyboard Actions

- SendKey

- SendKeyWidget

- ShowKeyPad

Page Actions
LoadFage -

Figure 83

9.2.1 PlayMedia

The PlayMedia macro allows you to start playing the videos when the Media Player widget is paused or
stopped. You have to specify the Media Player Widget in the macro properties.

9.2.2 StopMedia

The StopMedia macro allows you to stop the video running in the Media Player widget. You have to specify
the Media Player Widget in the macro properties.

9.2.3 ReloadMedia

The ReloadMedia macro allows you to stop the video running in the Media Player widget and play it from
the beginning. You have to specify the Media Player Widget in the macro properties.

9.2.4 PauseMedia

The PauseMedia macro allows you to pause the video running in the Media Player widget. You have to
specify the Media Player Widget in the macro properties.

9.25 BrowseMedia

The BrowseMedia macro allows you to browse the HMI panel and select a video to be loaded in the Media
Player widget. You have to specify the Media Player Widget in the macro properties.

9.3Keyboard Actions

The Keyboard macro actions include Send Key and Send Key Widget.
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9.3.1 SendKey

The SendKey macro is used to enter the predefined character to the Read/Write Widget. Define the
predefined key code and Shift key code to the Macro actions property. In runtime, first click the R/W numeric
Widget, then execute the Macro to send the predefined keys to the Numeric Widget. The action works on the
field currently being edited.

NOTE To use the SendKey macro, you must define the keypad type as Macro in the Numeric Widget
properties.

ot N
l Action List + — AV
#" Sendiey() Macro | Seript
- SendKey +  Macro Properties
- SendKeyWidgst __ | SendKey
Page Actions -
" LoadPage = keyCode 5
- HomePage ShiftkeyCode
- PrevPage
- Mext Page
- LastVisitedPage
- ShowDialog
- CloseDialog
- ShowMessage
- LaunchApplication
- Launch Browser -
[ 0k ] [ Cancel
_ e T e 4
Figure 84
w Properties *x
= Feld
= Value 100
ol Mumber Format &
.1 0 [E Keypad Type Macro
in o
Max 4096
Events
Text
Frame
Figure 85

9.3.2 SendKeyWidget

The SendKeyWidget macro is used to enter the predefined character or function for a specific Widget. To
use the macro, define the Widget ID and the key code in the Macro Properties.
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The Control List Widget (available in the advanced category of the Widgets Gallery) is a good example of
how this macro command can be used. Here Up and Down buttons have been implemented using the
SendKeyWidget macro. See the figure below for reference.

w Properties a x
bv e~ B B el (& &H &2
A L = ButtonWgt
o B I E EE ClickType momentary
it value 0
Fill Color [ 1230, 230, 250]
=] Ewvents
OnMousePress Action
OnMouseRelease Actil 1 Action I:
OnDataUpdate Action ,('
Configure /
Styles j
g General /
Position !‘
Enter
Action List | /
Action List = = /M W J‘
o Sendkeyviwidget() Macro | Seript
i SendKeyWidget »  Macro Properties
Page Actions = SendKeyWidget
- LoadPage .
.. HomePage widgetId controlList1l
- PrevPage kEYCUdE Up
- NextPage
. LastVistedPage i
- ShowDialog
- CloseDialog
- ShowMessage
- LaunchApplication
- LaunchBrowser
I'u'!uftiLang Actions -

Figure 86

NOTE To use the SendKey macro, you must define the keypad type as “Macro” in the Numeric Widget
properties.
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aiontie (N
I— ActionList = == M W
#* Sendkeywidget() Macro | Script
- SendKey +  Macro Properties
- ot = SendKeyWidget
Page Actions i :
- LoadPage = widgetld field4
- HomePage keyCode Up
- PrevPage
- MextPage
- LastVisitedPage
- ShowDialog
- CloseDialog keyCode
- ShowMessage Select the key to attach to
- LaunchApplication
- Launch Browser -
[ Ok ] [ Canhcel
= Y — T
Figure 87

9.3.3 ShowKeyPad

ShowKeyPad is used to show the default operating system touch keypad. Some operating systems might
not support it.

9.3.4 KeyboardMacros
KeyboardMacros enable and disable the use of keyboard Macros at runtime when using external keyboards.

You can also enable/disable macro execution related to keyboard studio side at the project level and at the
level of the single page.

A dedicated property is available in the project property sheet and in the page property sheet.
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Properties a x gt
(& &0 & =
= Page o
=
Id Pagel o
Width 480 =
=
Height 272
Background [ [255, 255, 255]
Template none
Static File Typi png
JavaScript Deb false

Keyboard mac itme ,.I
Events false
.............................................

Figure 88

9.4Page Actions

The Page Actions macros are used for page navigation and to load-specific pages. Please note that the
Page Actions are programmable ONLY in the released state.
The Page Actions macros are available for Alarms, Schedulers and Mouse Release Events.

9.4.1 LoadPage

The LoadPage macro allows you to load the selected page of the project when the macro is executed.

Macro | Script

Widget Actions +  Macro Properties

- Show\Widget = LoadPage
- TriggerlPCamera

-~ SlideWidget ST [+
- RefreshEvent Load Pagﬁ‘
LA

m

Keyboard Actions

- SendKey

- SendKeyWidget
age Actions

- LoadPage

- HomePage

- PrevPage

- Mext Page pagelame
- LastVistedFPage )

.. ShowDidlog LoadPageAction pagename
- CloseDialog

- ShowMessane

=

Figure 89
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9.4.2 HomePage

The HomePage macro allows you to specify the home page.

By default, the home page is the first page of the project. However, you can change the home page in the
project configuration properties. To change the home page, double click on the project name item in Project
View. Once in Properties, choose the home page (as shown in the figure below).

File Edit PRun Format View Window Help
MR NN T N< N WEER N @ B A Langl d .
¢ ProjectView o X :’ Proj w Properties o X [[ml]
‘®m | -8 Projectl = Project Widget =
[ ) @
% |5 Projectl Id Project1 o
2 E—JFF“ Pages Full Path G:\Temp\Proj =
B 1: Pagel Version r
=-F® Config
..... €\ Protocols Context Menu on delay
..... =] Tags Image DB Enable | true
[ Trends =l Behavior
..... é Alarms Home Page Pagel.jmx
----- ﬂ" Events Buffer PageWidth 1024
----- " Scheduler :
_ PageHeight 768
..... % MultiLanguag :
L0 Security Display Mode | Landscape
Figure 90

9.4.3 PrevPage

The PreviousPage macro allows you to navigate the HMI Runtime to the previous page.

9.4.4 NextPage

The NextPage macro allows you to navigate the HMI Runtime to the next page.

9.45 LastVisitedPage

The LastVisited page macro allows you to load the page previously displayed on HMI Runtime.

9.4.6 ShowDialog

The ShowDialog macro allows you to display the Dialog Pages defined in the project. After the execution of
this macro, the HMI Runtime displays the specified Dialog Page.
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Action List == == N W

#* ShowDialog) Macro | Script

- ShowDialog +  Macro Properties
- CloseDialog = ShownDialog

- ShowMessage
- LaunchApplication | fileName | IT
Load Page

- LaunchBrowser
Tag Actions

- Data Transfer

- ToggleBit

- SetBit

- Getbit fileName

- Write Tag ShowDigdgAction fileMame
- StepTag

- SubscrbeGroup -

e |

i | Page List / =5

Dialog page 1.jmx
Dialog Page 2.jmx

[ Ok ] [ Cancel

Figure 91

9.4.7 CloseDialog

The CloseDialog macro is applicable only to Dialog pages. The Close Dialog macro allows you to close the
dialog page currently displayed.

9.4.8 ShowMessage

The ShowMessage macro allows you to display warning message popup when the macro is executed. Type
the message that you wish to have displayed while executing the macro.
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9.4.9 LaunchApplication

The LaunchApplication macro allows the user to launch an external application when the macro is executed.
To configure, the following information must be provided in order to execute the requested application.

App Name
Name of the executable file complete with extension. For example, if you want to run Notepad application,
the argument should be “notepad.exe"

Path
Application path; when the target platform is Windows CE, the path is \flash\qthmi. This is the folder that you
see and have access to, when connecting to the panel via FTP.

Arguments

Some applications may need arguments to be passed. For example, to open a pdf file, specify the file name
so that, while launching the application, the file name set in the argument is loaded on the application. For
example, \flash\gthmi\Manual.pdf will open the document “Manual.pdf”.

Single Instance

This argument allows the application to start in a single instance or multiple instances. When single instance
is selected, the system first verifies whether the application is already running. If it is running, then the
application pulls it up (the operating system puts it in the foreground to the user’s attention); if it is not
running, then the application is launched.

9.4.10 LaunchBrowser

LaunchBrowser opens the default web browser. You can define the URL address of the webpage in the
arguments.

NOTE This macro only works in platforms that have a default web browser as application. Not all platforms

are equipped with a default web browser. For example, this macro is supported in OS based on Windows CE
PRO with Internet Explorer enabled.

9.4.11 LaunchVNC

Use this macro to execute VNC server configuration form. This macro is working only on embedded devices
WCE based.

9.4.12 LaunchUpdater

Use this macro to update project and/or runtime searching for it into an external device. Using “Path”
parameter is possible to specify folder where searching the update package.

Examples of path could be:
- \USBMemory (for USB devices in WCE)
- \Storage Card (for SD devices in WCE)

NOTE This macro is supported only in hmi panels based on WCE OS.
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9.4.13 LockScreen

Use this macro to lock touch screen temporary. Usually this action is used to allow users to cleanup touch
screen without fire events pressing buttons or other widgets on page.

Screen - Time remaining to unlock system variable can be used to check time remaining to unlock
screen.

9.5MultiLang Actions

The Multi-Language (MultiLang) actions are used to select and modify the languages used in the application.

9.5.1 SetLanguage

The SetLanguage macro allows you to set the current display language. In Macro Properties, enter in the
Language. At runtime, while executing the macro, the selected language will be applied to all applicable
Widgets.

9.6 Tag Actions

The Tag Actions macros are used to interact with the application Tags.

9.6.1 DataTransfer

DataTransfer macros allow you to exchange data between two controllers, between registers within a
controller, or from system variables to controllers (and vice versa). “SrcTag" refers to the source Tag and
“DestTag" refers to Destination Tag. The various Tag types include a Controller Tag, a System Tag, a
Recipe Tag and Widget Property.

9.6.2 ToggleBit

Toggle Bit macros allow you to “toggle" (meaning set or reset) a bit of a tag. The Bitindex allows you to
select the bit to be inverted: this requires a read-modify-write operation; the read value is inverted and then
written back to the controller tag.

9.6.3 SetBit

The SetBit macro allows you to set the selected bit. When the macro is executed, the value of the selected

bit is set to “1".
The Bitindex property allows you to select the bit position inside the Tag.

9.6.4 ResetBit

The ResetBit macro allows you to reset the selected bit. When the macro is executed, the value of the
selected bit value is set to “0”
The BitIndex property allows you to select the bit position inside the Tag.
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9.6.5 WriteTag

WriteTag allows you to write constant values to the controller memory. In the Macro properties you have to
specify the Tag name and the value to be written.

9.6.6 StepTag

The StepTag macro allows you to increment or decrement the value of a Tag.

TagName
Name of the Tag you want to Step

Step
Step value

Do not step over limit
Step Limit enables

Step Limit

If the “Do not step over limit” is true, then the macro will work until the Tag value reaches the specified value.
9.6.7 ActivateGroup

This macro activates tags update for a group of Tags.

Usually tags are updated when used in the current page (or always when defined in Tag Editor as Active
=True). Using this macro it is possible to force the system to keep a group of tags always active (updated)
independently if they are used on the current page or not.

9.6.8 DeactivateGroup

Deactivate a group of tags. Using this macro system stops reading a group of tags that had been previously
activated

9.7 Trend Actions

Trend actions are used for both Live Data Trends and the Historical Trends Widget.

9.7.1 RefreshTrend

The RefreshTrend macro is used to refresh the Trend window. You have to specify the Trend Widget in the
macro properties. This macro can be used in any of available graph widgets like Historical trends, Scatter
Diagram and Consumption Meter.

9.7.2 Scroll Left Trend

The ScrollLeftTrend macro is used to scroll the Trend window to the left side, by one-tenth (1/10) of the
page duration.

NOTE W.ith the Real-Time trend it is recommended pausing the trend using the macro PauseTrend,
otherwise the window is continuously shifted to the current value.
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9.7.3 Scroll Right Trend

The ScrollRightTrend macro is used to scroll the Trend window to the right side, by one-tenth (1/10) of the
page duration.

NOTE W.ith the Real-Time trend it is recommended pausing the trend using the macro PauseTrend,
otherwise the window is continuously shifted to the current value.
9.7.4 PageleftTrend

The PageLeftTrend macro allows you to scroll the Trend window by one-page duration. For example, if the
page duration is 10 minutes, then, with the PagelLeftTrend macro you can scroll the trend left for 10 minutes.

9.7.5 Page Right Trend

The PageRightTrend allows you to scroll the Trend window by one-page duration. For example, if the page
duration is 10 minutes, then, with the PageRightTrend macro, you can scroll the trend right for 10 minutes.

9.7.6 Page Duration Trend

The PageDuration macro is used to set the page duration of the Trend window. In Macro Properties, you
must define the Trend Name and Page Duration.

NOTE You can also use a combo box Widget to select the page duration at Runtime.

9.7.7 Zoom In Trend

ZoomInTrend macro allows you to reduce the page duration.

9.7.8 ZoomOutTrend

ZoomOutTrend macro allows you to make the page duration longer.

9.79 Zoom Reset Trend

ZoomResetTrend macro allows you to reset the zoom level back to the original zoom level.

9.7.10 Pause Trend

PauseTrend macro allows you to stop plotting the Trend curves in the Trend window. When used with Real
Time Trend the plotting stops when the curve reaches the right border of the graph. The Trend logging
operation is not stopped from the panel when this macro command is used.

9.7.11 ResumeTrend

ResumeTrend macro allows you to resume a Trend plotting you previously paused. After executing the
ResumeTrend macro, the Trend window will start to plot the data to the Trend once again.
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9.7.12 Show Trend Cursor

The ShowTrendCursor macro allows the user to know the value of the curve at a given point on the X-Axis.
Use this macro to activate the Trend Cursor. At Runtime, upon executing the macro, a Vertical Line (Cursor)
will display in the Trend Widget. When the Graphic Cursor is enabled, the scrolling of the Trend is stopped.
You can implement Scroll Cursor macros to move the Graphic Cursor over the curves, or to move the entire
Trend window.

Action List

ActionList == == /A W
#* ShowT rendCursor) Macro | Seript

DeactivateGroup »  Macro Properties
Trend Actions
- Refregh Trend
- ScrollLeftTrend Trend Name | TrendWindow2
- ScrollRight Trend Show Cursor | true
- PageLeft Trend
- PageRight Trend
- Page Duration Trend
- ZoomInTrend
- ZoomOut Trend
- ZonomReset Trend
- PauseTrend
- ResumeTrend
- Scroll TrendCursor
Alam Actions
- SelectAllAlamms
- AckAlam -

-| ShowTrendCursor

m

Ok ] l Cancel

Figure 92

9.7.13 ScrollTrendCursor

The ScrollTrendCursor macro allows the user to scroll the Trend Cursor in forward or reverse time direction.
The Y-Cursor value will display the Trend value at the point of the cursor. The scrolling percentage can be
set at 1% or 10%. The percentage is calculated based on the Trend window duration.
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Action List

Action List = — AW

#* ScrollTrendCursor() Macro | Script

- Seroll TrendCursor »  Macro Properties

Alarm Actions = ScrollTrendCursor
- SelectAll Alarms

. Ak Alamm Trend Name | TrendWindow1
- ResetAlam Scroll Direction Forward

- EnableMlams

Syetom Actons Scroll Percents 194

- Restart

- EnterCFGMode

- EnterJPMode

- SaveConfiguration
- ControlUserLED
- Dump Trend

- DeleteTrend

- DumpEventArchive Scroll Percentage

- DeleteEventArchive Cursor scroll length in %
- Reset Proto EmCount

Recipe Actions 8

[ Ok ] [ Cancel

Figure 93

9.7.14 ScrollTrendtoTime

The ScrollTrendtoTime is used to scroll the Trend Window to a particular point in time. When you execute
this macro the Trend Window will move to the time specified in the Macro Properties.

-

ActionList = =— MW
#" ScrolTrendT oTime(] Seript

- Refresh Trend »  Macro Properties

- ScrollLeft Trend = ScrollTrendToTime
- ScrollRight Trend

- PageleftTrend Trend Name TrendWindow?2
- PageRight Trend Scroll To Position Center

- PageDurationTrend Scroll Trend to Time
- ZoomIn Trend

- ZoomOut Trend H Select Tag

- FoomReset Trend
- PauseTrend

- ResumeTrend

- Show TrendCursor
- Scroll TrendCursor

.- Scroll Trend to Time
Aam Actions Scroll Trend To time
- SelectAllAlams

- AckAlam

[ TR ¥ N—

Ok I [ Cancel

Figure 94
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This Action may be very useful when you need to scroll at a specific position in a trend window based on the
time at which a certain event occurs. This can be achieved by configuring an action for that alarm (event)
that executes a Data Transfer of the system time into a Tag; when selecting that tag as “ScrollTrendtoTime”

parameter (see above figure) the trend windows will be centered at the time in which the event has been
triggered.

9.7.15 ConsumptionMeterPageScroll

The ConsumptionMeterPageScroll Macro is used to scroll page back/forward in ConsumptionMeter widget.

Available parameters are:
e Trend Name: Trend widget ID (ex. TrendWindow3)
e Page Scroll Direction: Forward/Reverse

-

Action List

Action List == = /M W

#* ComsumptionteterP, . Action | Script

- ZoominTrend - Action Properties

-~ ZoomOutTrend - ConsumptionMeterPageScroll
- ZoomReset Trend

. PauseTrend Trend Mame | TrendWindow3
- Resume Trend Page Scroll Dir Forward

- Show TrendCursor

- Seroll TrendCursor )l
- Seroll Trend TaTime (=]

- ConsumptionMeterPageScroll
=1 Alarm Trend Name
- SelectAllAlams Trend Widget ID
- Aok Alam
- ResetAlam —

Ok ] [ Cancel

e —————————————

Figure 95

9.8 Alarm Actions

Alarm Actions are macros used to acknowledge or reset the alarms. The actions listed here can be used to
build a custom Widget for the alarm display; you can observe an example of how these are used in the
default Alarm Widget, available in the Widget gallery.
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Mew Seript

- PauseTrend +  Macro Properties

- Resume Trend

- Show TrendCursor

- Scroll TrendCursor
- Scroll Trend ToTime

[m Aceors [

- SelectAll Alarms

- Aok Alam

- Reset Alam i

- EnableAlamms
Event Actions 2

- ScrollEvertsBackward

‘... SerollEvertsForward
System Actions

- Restart

- EnterCFGMode

i Enter0PMade

SaveCorfiguration

] [ Cancel

Figure 96

9.8.1 SelectAllAlarms

This macro allows you to select all the Alarms in the Alarm Widget.

9.8.2 AckAlarm

The AckAlarm macro allows for acknowledging the selected Alarms.

9.8.3 ResetAlarm

The ResetAlarm macro allows you to reset the selected acknowledged Alarms.

9.8.4 EnableAlarms

The EnableAlarms macro is used in conjunction with the “Save” button of the Alarm widget; it is required to
properly save at runtime the changes made in the “Enable” check boxes from the “Enable” column in the
alarm widget.
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Ack Reset Save

Figure 97

9.9Event Actions

9.9.1 ScrollEventsBackward

Macro used by Alarm history widget to scroll events/alarms backward in table view (event buffer widget).

9.9.2 ScrollEventsForward

Macro used by Alarm history widget to scroll events/alarms forward in table view (event buffer widget).

9.10System Actions

The System Actions macro allows you to use the system properties in Runtime.

9.10.1 Restart

The Restart system macro allows you to restart Runtime. After executing the macro, the Runtime goes to

configuration mode and restart..
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9.10.2 ControlUserLED

This allows the switching ON, OFF or blinking of the User LED. In the action properties, the LED action can
be set to OFF, ON or Blink.

r ™

Action List

Action List == = A W
#* ControlllserLED() Macro | Script

‘... Seroll EventsForward +  Macro Properties

System Actions = ControlUserLED
- Restart :

... [ —T——— LEDACEion OFF
- Dump Trend

- Delete Trend

- Dump Event Archive
- DeleteEvent Archive
- Reset Proto EmCourt
- SafelyRemove Media
Recipe Actions

- Down Load Recipe

- UpLoadRecipe -

[

(0]3 ] [ Cancel

L A

Figure 98

NOTE Not all HMI models have User LED indicators. Check the product documentation for further
information.

9.10.3 DumpTrend

The DumpTrend macro is used to store the Historical Trend data to external drives, such as a USB drive or
an SD card. In the macro properties, you must configure the Historical Trend name you want to store and the
destination folder path. If you use a USB drive plugged into the USB port, the path will be \USBMemory or if
you use an SD Card, the path will be \Storage Card, followed by the specified folder in the memory.

NOTE The execution of the Dump action will automatically force a flush to disk of the data temporarily

maintained in the RAM memory. See the chapter “Trend Editor” for further information about the policy used
to save sampled data to disk.

NOTE The external drives plugged on the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.
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Action List

ActionList = =— A W
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- Dump Trend o
- DeleteTrend Ter s
- Dump Event Archive FolderPath \USBMemory
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Recipe Actions -
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. WiiteCument RecipeSet ;’he nagne of the trend to be
- DownLoadCurRecipe umpe
- UpLoadCurRecipe 5
Ok ] [ Canizel
Figure 99
DumpAsCSV

If this option is set to true, then the buffer will be directly dumped to the specified location as a *.CSV file in
the format specified below. If it is set as False, then the dump of the trend file will be in binary format; the
result of the dump operation is actually a couple of files, one with extension .dat and one with extension .inf.
An external utility is then required to convert it to a CSV format. These two files are both required by the
utility to operate the conversion.

DateTimePrefixFileName

When this Option is enabled the dumped File will have the Date and Time as Prefix to the hame of the File.
For example if we are making a Dump at 10.10AM on 1-1-2012, then the file name will look like

D2012 01 _01 _T10 10 Trendl.csv. [DYear_Month_day THour_ Minute Filename]

This helps to know the Time at which the Dump was executed and also to identify which one is the latest.

timeSpec
This option defines the time format used when dumping the trend to file.
e Local: the time values exported are the time of the HMI device.
e Global: the time values exported are in the Coordinated Universal Time (UTC) format.

Example:
Local 2012-10-11T05:13:43.724-07:00
Global 2012-10-11T12:13:43.7247

NOTE The software tool required to convert the dump files to CSV are available in the HMWIN Studio
folder called “Utils” under the directory where the software is installed.

The tool needed to convert trend buffers is called “TrendBufferReader.exe".
The TrendBufferReader.exe tool can be invoked using a batch file with the following syntax:

TrendBufferReader -r Trendl Trendl.csv 1
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where Trend1 is the name of the trend buffer without extension resulting from the dump (original file name is
trendl.dat) and Trendl.csv is the name desired for the output file.

The resulting CSV file has 5 columns with the following meaning:

Data Type, Value, Timestamp(UTC), Sampling Time(ms), Quality

Where:

Data Type:

Code that gives information about the data type of the sampled Tag according to the following codes:

Code

Type

0

Empty

Boolean

Byte

Short

Int

Unsigned Byte

Unsigned Short

Unsigned Int

Float

O] O N| O Oof & W[ N|

Double

Value

Value of the sample

Timestamp(UTC)

Timestamp in UTC format

SamplingTime(ms)
Sampling interval time in milliseconds

Quality

Gives information on the tag value quality. The information is coded according the OPC DA standard; the
information is stored in a byte data (8 bits) currently defined in the form of three bit fields; Quality, Sub status
and Limit status. The 8 Quality bits are arranged as follows: QQSSSSLL

For a complete and detailed description of all the single fields, please refer to the OPC DA official
documentation. Shown below are the most commonly used quality values returned by the HMI acquisition

engine:
Quality Code Quality Description
0 BAD The value is bad but no specific reason is known
There is some server specific problem with the configuration.
4 BAD For example, the tag in question has been deleted from the
configuration file (tags.xml).
This quality may reflect that no value is available at this time,
8 BAD for reasons such as the value may have not been provided by
the data source.
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12 BAD A device failure has been detected

16 BAD Timeout occurred before device responded.

24 BAD Communications have failed.

There are no data found to provide upper or lower bound value

28 BAD (trend interface specific flag).

No data have been collected (i.e. archiving not active. Trend
interface specific flag).

32 BAD When the HMI return online after a reboot or from a condition
where sampling stopped, a sample with quality value 32 is
added to indicate this temporary offline status.

64 UNCERTAIN [There is no specific reason why the value is uncertain.

65 UNCERTAIN There is n(? specm’c reason why the_ vglue is uncertain. (The
value has ‘pegged’ at some lower limit)

66 UNCERTAIN There is nc? specm’c reason Why the _value is uncertain. (The
value has ‘pegged’ at some high limit.)

67 UNCERTAIN There is no specific reason why the value is uncertain. (The

value is a constant and cannot move.)

The returned value is outside the limits defined for it. Note that
84 UNCERTAIN |in this case the “Limits” field indicates which limit has been
exceeded but the value can move farther out of this range.

The returned value is outside the limits defined for it. Note that
in this case the “Limits” field indicates which limit has been
exceeded but the value can move farther out of this range.
(The value has ‘pegged’ at some lower limit)

85 UNCERTAIN

The returned value is outside the limits defined for it. Note that
in this case the “Limits” field indicates which limit has been
exceeded but the value can move farther out of this range.
(The value has ‘pegged’ at some high limit.)

86 UNCERTAIN

The returned value is outside the limits defined for it. Note that
in this case the “Limits” field indicates which limit has been
exceeded but the value can move farther out of this range.
(The value is a constant and cannot move.)

87 UNCERTAIN

192 GOOD

9.10.4 DeleteTrend

The DeleteTrend macro allows you to delete saved Trend data from the file. In Macro Properties, define the
Trend name from which you want to delete the trend logs.

9.10.5 DumpEventArchive

The DumpEventArchive macro is used to export the Historical Alarm log and Audit Trail data to external

drives, such as a USB memory or SD card. If you use a USB drive the path will be \USBMemory or if you
use an SD Card the path will be \Storage Card, followed by the specified folder in the memory.
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NOTE The external drives plugged on the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.

In the Macro Properties, you need to configure the Event buffer name that you want to dump and the
destination folder path. The DumpConfigFile property must be set to true when you plan to convert the
dumped files to CSV.

DumpAsCSV

If this option is set to true, the buffer will be directly dumped to the specified location as a *.CSV file. If itis
set as false, then the dump of the trend file will be in binary format an external tool is then required to convert
it to a CSV format.

DateTimePrefixFileName

When this option is enabled the dumped file will have the Date and Time as prefix to the name of the file.
For example if we are making a Dump at 10.10AM on 1-1-2012, then the file name will look like

D2012 01 _01 T10 10 _alarmBufferl.csv. [DYear_Month_day THour_Minute_Filename]

This helps to know the Time at which the Dump was made and also to identify which one is the latest

NOTE This option is only supported when exporting to CSV directly.

timeSpec
This option defines the time format used when dumping the event archive to file.
e Local: the time values exported are the time of the HMI device.
e Global: the time values exported are in the Coordinated Universal Time (UTC) format.

Example:
e Local 2012-10-11T05:13:43.724-07:00
e Global 2012-10-11T12:13:43.724Z

When exporting Event buffers in binary format assuming the DumpConfigFile option is set to true
(recommended settings), the result of the dump action execution is 2 folders; one is called “data” and it
contains the data files, the second one is called “config” and it does contain the configuration files needed by
the tool to recover the complete information for proper conversion to CSV.

Once the two folders are copied from the root of the USB drive to the computer disk, the folder structure will
look as follows:

Aconfig\
alarms.xml
eventconfig.xml
Adata\
AlarmBufferl.dat
AlarmBufferl.inf
A
AlarmBufferReader.exe

NOTE The utility is distributed in HMWIN Studio in the folder Panasonic\HMWIN\Utils.
The AlarmBufferReader can be called from command line with the following syntax:
AlarmBufferReader AlarmBufferl FILE ./AlarmBufferl.csv

Where AlarmBufferl is the name of the dumped .dat file without extension and AlarmBufferl.csv is the
desired output file name.
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Action List

Action List = == A W
#" DumpE ventarchive() Macro | Script

Event Actions +  Macro Properties
- ScrollEverts Backward
- Scrol EventsForward

System Actions EventArchive AuditTrail

- Restart FolderPath \USBMemory\,

- CantrolUserLED DumpConfigFile | false
- DumpTrend

- DeleteTrend DumpAsCSY true

- Dump Event Archive DatetimePreficedF trua

- Delete Evert Archive timeSpec Global
- ResetProto EmCournt
- SafelyRemoveMedia
- CopyCodesys Project
Recipe Actions

- DownlLoadRecipe

- |IpLoadRecipe -

- DumpEventArchive

m

Ok ] [ Cancel

L L

Figure 100

The utility called “AuditTrailBufferReader.exe" is available for Audit Trail buffers.
NOTE The action must to be configured with the option DumpConfigFile set to true.

The result of the dump is a directory structure similar to the one generated for Events.
The conversion tool can be called from the command line according to the following syntax:

AuditTrailBufferReader AuditTrail FILE ./AuditTrail.csv

Where AuditTrail is the name of the dumped buffer without extension and AuditTraill.csv is the desired
output file name.

9.10.6 DeleteEventArchive

The DeleteEventArchive macro allows you to delete saved Event buffers log data from the file. In the macro
properties, define the Event buffer name that you want to delete from the Event logs.

9.10.7 ResetProtoErrCount

The ResetProtoErrCount macro is used to reset the Protocol Error Count System Variable. See the chapter
“System Variables“for further information about system variables.

9.10.8 SafelyRemoveMedia

If you unplug an SD Card or a USB drive from the HMI while it is transferring or saving information, you risk
losing some information. This macro provides a way to help you safely remove such devices.
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Figure 101

9.10.9 CopyCodesysProject

The action CopyCodesysProject copy the CODESYS 2.3 project files (.prg, ,chk and .sdb) located in the
source path into the panel CODESYS folder. Files are automatically renamed to DEFAULT.CHK ,
DEFAULT.PRG , BOOT.SDB if it is of different name.

After copy of files the CODESYS module is stopped, reloaded and started again.

Parameters:
e Source Path path of project into external storage. Ex. \USBMemory\Codesys
e Copy Symbols if set to true copy also .SDB symbols file (used by CODESYS 2 ETH protocol).

To generate CODESYS project files, proceed as follow from CODESYS:
1) Execute Project -> Rebuild All (to generate an updated SDB symbol file)
2) Execute Online -> Create boot project (to generate the .CHK and .PRG files)

The CopyCodesysProject action can be used also to transfer a CODESYS project from one hmi panel to
another. In this case files needed from hmi running CODESYS project are following:

- DEFAULT.CHK

- DEFAULT.PRG

- BOOT.SDB

Using System variables PLC -> PLC Status and PLC -> Get CopyCodesysProject Action Status the
status of PLC and of CopyCodesysProject action can be verified.
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9.11Recipe Actions

The Recipe Actions macros are used in programming the recipe management.

9.11.1 DownlLoadRecipe

The DownloadRecipe macro allows you to transfer a set of Recipe data to the controller. In macro properties,
select the Recipe in the Recipe Name field and select the Recipe set you want to download. To download
the currently selected Recipe set, select “curSet" in RecipeSet.

CER
Action Ligt = == M W

#* DownlLoadR ecipe(] Macro | Script

- DumpEventArchive Macro Properties
= DownlLoadRecipe

- DeleteEvent Archive
- ResetProto EmCount
.. SafelyRemoveMedia RecipeMame | Recipel
Recipe Actions RecipeSet curset
- DownlLoadRecipe

- UpLoadRecipe

- WiiteCument Recipe Set
- Down LoadCurRecipe
- UpLoadCurRecipe

- ResetRecipe

- DumpRecipeData

- Restore Recipe Data
User Management Actions

Cancel

Figure 102

9.11.2 UpLoadRecipe

The UploadRecipe macro allows you to transfer the controller data to the Recipe set data. In the macro
properties, select the Recipe in the Recipe Name and select the Recipe set that you want to upload. To
upload to the currently selected Recipe set, select “curSet" in RecipeSet.
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#" UpLoadR ecipe() Seript

- DumpEvent Archive Macro Properties

- Diglete Bvent Archive = UpLoadRecipe
- ResetProto EmCount
- SafelyRemoveMedia Recipelame | Recipel
Recipe Actions RecipeSet curseat
- DownLoadRecipe

- UpLoadRecipe

- WiteCument Recipe Set

- DiownLoadCurRecipe

- UpLoadCurRecipe

- ResetRecipe
DumpHecipeData H
- Restore RecipeData

User Management Actions

Ok I l Cancel

Figure 103

9.11.3 WriteCurrentRecipeSet

The WriteCurrentRecipeSet macro allows you to set the selected Recipe as current Recipe Set. In Macro
Properties, select the Recipe and Recipe Set you want to set as the Current Recipe in runtime.

I ActionList = = M W
#" wiiteCunentF ecipe. Seript

- DumpEventArchive +  Macro Properties

- DeleteEvent Archive = WriteCurrentRecipeSet
- ResetProto EmCount
- SafelyRemoveMedia RedpeName | Recipel
Recipe Actions RecipeSet Satl

- DownlLoadRecipe

- UpLoadRecipe

- WiteCument Recipe Set

- DownLoadCurRecipe

- UpLoadCurRecipe

- ResetRecipe
DumpHecipeData E|
- Restore RecipeData

User Management Actions

Ok I ’ Cancel

Figure 104
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9.11.4 DownlLoadCurRecipe

The DownloadCurRecipe macro allows you to transfer the current set of Recipe data to the controller. No
parameter is required in the Macro Properties. This will download the currently selected Recipe and Recipe
set to the controller.

Action Ligt = == M W

#* DownLoadCurPecip... Macro | Script

- DumpEventArchive »  Macro Properties

- DeleteEvent Archive DownlLoadCurRecipe
- ResetProto EmCount

- SafelyRemoveMedia

Recipe Actions

- DownlLoadRecipe

- UpLoadRecipe

- WiiteCument Recipe Set

- UpLoadCurRecipe

- ResetRecipe =
- DumpRecipeData H
- Restore Recipe Data

User Management Actions

Cancel

Figure 105

9.11.5 UploadCurRecipe

The UploadCurRecipe macro allows you to transfer the set of controller data values to a Recipes set. No
parameter is required in the Macro Properties. This will upload the currently selected Recipe from the
controller.
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#" UpLoadCurR ecipel) Seript

- DumpEvent Archive »~  Macro Properties

- Delete Evert Archive UpLoadCurRecipe
- Reget Proto EmCount

- SafelyRemoveMedia

Recipe Actions

- DownLoadRecipe
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- WiteCument Recipe Set

- DiownLoadCurRecipe

& UpLoadCurRecipe

- ResetRecipe
DumpHecipeData H
- Restore RecipeData

User Management Actions

Ok I l Cancel

Figure 106

9.11.6 ResetRecipe

The ResetRecipe macro allows you to restore the factory settings for the Recipe data. The uploaded
Recipes will be replaced with the original Recipe data. In the macro property, select the Recipe that you want
to reset to factory settings.

| Action List + —_ Y
#" ResetRecipel) Script

- DumpEvent Archive »~  Macro Properties

- DeleteEvent Archive = ResetRecipe
- Reset Proto EmCount
- SafelyRemoveMedia Recipelame | Recipel
Recipe Actions

- DownLoadRecipe

- UpLoadRecipe

- WiteCurent Recipe Set

- DiownLoadCurRecipe

- UpLoadCurRecipe

- ResetRecipe
DumpF{ecipeData H
- Restore RecipeData

User Management Actions

Ok I l Cancel
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Figure 107

9.11.7 DumpRecipeData

The DumpRecipeData macro is used to dump recipes to internal or external storages. In the Macro
Properties, define the location where to save the dumped file. Recipe data is saved in CSV format.
Dump can be done in any external storage like USB, SD or network path.

NOTE The external drives plugged in the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.

r 5

Action List

ActionList o= =— A W

#* DumpRecipeD atal) Action | Script

- Recipe 4 Action Properties
- DownlLoadRecipe = DumpRecipeData "
- |pLoadRecipe a
- WriteCumrent RecipeS RecipeMame | AllRecipes
- DownLoadCurRecipe FilzPath \Storage Card |
- UpLoadCurRecipe FileName RecipeData 3
- ResetRecipe .
W e i DatetimePrafiy false
- RestoreRecipeData TimeSpec Local

= User A
- LogOut — | FilePath
. Switchlser The folder location to where the data to be dumped.

i~ ResetPassword i
€ | i 3

Ok ] [ Cancel

———————————————————————————

Figure 108

DateTimePrefixFileName

When this option is enabled the dumped file will have the Date and Time as prefix of the filename.

For example: if we are making a Dump at 10.10AM on 1-1-2012, then the file name will look like
D2012_01_01_T10_10_recipel.csv. [DYear_Month_day THour_Minute_Filename]

This helps to know the Time at which the Dump was executed and also to identify which one is the latest.
TimeSpec define time format, Local for HMI time and Global for UTC time.

9.11.8 RestoreRecipeData

The RestoreRecipeData macro allows you to restore the Recipe data previously saved. In Macro Properties,
provide the file full path of the Recipe files. Recipes to restore can be in any external storage like USB, SD or
network paths.

NOTE The external drives plugged on the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.
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Figure 109

9.12User Management Actions

User Management Actions macros have been designed for user management and security settings in
Runtime.

9.12.1 LogOut

The LogOut macro allows you to log off the current user in Runtime. After executing the LogOut macro, the
HMI behavior depends on whether a Default user is configured in the project or not.

If there is a Default user, the LogOut automatically logs in the Default user. If there is not a Default user or
you logout from the Default user, then the log-in screen is shown.
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Figure 110

9.12.2 SwitchUser

The SwitchUser macro allows you to switch between two users without logging-out the logged-in user. The
server continues running with the previously logged-in user, until the next user logs in. This means, after
executing the SwitchUser macro, the runtime will display the User Login template. Internally, however, the
server runs with the previously logged-in user. This action is useful for ensuring that there is always one user
logged onto the system.
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Action List
Action List == == /M %
#" Switchll zer) Macro | Seript
Recipe Actions »  Macro Properties
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- UpLoadRecipe
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Figure 111
Click on the “Back" button to go back to the previously logged-in user.
*
' Back
I#
User name:
Password:
l  Signin
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Figure 112

9.12.3 ResetPassword

The ResetPassword macro allows the current user to restore his or her original password; this macro will
restore settings specified in the project for the current user password. No parameter is required to set this
macro.

Action List

Action List == =— M W

#" FlesetPazsword() Macro | Seript

- DownLoadRecipe +  Macro Properties
- UploadRecipe

- WriteCurmrent Recipe Set
- Down LoadCurRecipe
- UpLoadCurRecipe

- ResetRecipe

- DumpRecipeData

- RestoreRecipeData
|ser Management Actions
- LogOut

- SwitchUser

™ Reset Passwaord

- AddUser

- DeleteUser

- Edit Users

- Delete UMCynamicFile
- Bxport Users

- Import Users

ResetPassword

1

Ok ] [ Cancel

Figure 113

9.12.4 AddUser

The AddUser macro is used to add users at runtime. When this macro is executed, a template page pops up,
where parameters for the user can be set. These parameters include Username, Password, Group,
Comments, flags like ‘password must contain numbers’, ‘password must contain special character’, ‘user
must change his initial password’, ‘enable logoff time’ and ‘Inactivity Logoff Time’. The User Log is shown in
the figure below.
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User name: useri

Password: useri

Group: admin -

Comments:

Password must contain number: false -

Password must contain special character: false -

User must change his initial password: false -

Enable logoff time: false -

Inactivity logoff time: 0 min
Figure 114

9.12.5 DeleteUser

The DeleteUser macro is used to delete users at runtime. Upon executing this macro, a template page will
pop up where you can select the user you wish to delete. No parameters are required to set this macro. After
executing the macro, the Delete User form will be displayed, as shown in the figure below.
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User name: |user1 - |

Password: useri

Group: | admin - |

Comments:

Password must contain number: false -

Password must contain special character: false -

User must change his initial password: false -

Enable logoff time: false -

Inactivity logoff time: 0 min

| Delete | Cancel

Figure 115

9.12.6 EditUsers

The EditUsers macro is used to edit users at runtime. When executing this macro, a template page pops up.
Here you can select a user and modify this user's parameters (such as Username, Password, Group,
Comments, flags like ‘password must contain numbers’, ‘password must contain special character’, ‘user
must change his initial password’, ‘enable logoff time’ and Inactivity Logoff Time). After executing the macro,
a User Edit form will pop up, as shown in the figure below.
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User name: |user1 - |

Password: useri

Group: | admin - |

Comments:

Password must contain number: false -

Password must contain special character: false -

User must change his initial password: false -

Enable logoff time: false -

Inactivity logoff time: 0 min

| Apply | Cancel

Figure 116

9.12.7 DeleteUMDynamicFile

The DeleteUMDynamicFile macro allows you to delete the dynamic user management file. This means that
the users created, edited, or deleted in Runtime will be erased, and the server will restore the settings from
the project, originally downloaded from HMWIN Studio. No Macro Properties are required.

9.12.8 ExportUsers

The ExportUsers macro allows exporting user details to an xml file (usermgnt_user.xml). User details will be
in encrypted form. In the Macro Properties, the destination folder path must be set to the location where the
usermgnt_user.xml file is saved.

If using a USB drive plugged in to the USB port, the path will be “\USBMemory", followed by the specified
folder in the memory (or left empty for root folder).

NOTE The external drives plugged in the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.

Since the file is encrypted, there is no way to edit the user configuration from this exported file. This action is
most useful for making a backup to be used for a later restore.
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Figure 117

9.12.9 ImportUsers

The ImportUsers macro allows importing user details from an xml file named “usermgnt_user.xml". The path
of the folder where the usermgnt_user.xml file is located must be specified in the Macro Properties.

If using a USB drive plugged into the USB port, the path will be “\USBMemory", followed by the specified
folder in the memory (or left empty for root folder).

NOTE The external drives plugged in the USB port of the panel must have format FAT or FAT32. NTFS
format is not supported.
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9.13Print Actions

a N
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Figure 119
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9.13.1 PrintGraphicReport

The PrintGraphicReport macro allows you to print a graphic report. You have to specify the report name in
the combo box reportName. The option silent (default value is true), if set to false, allows you to open a
dialog at runtime which asks the user to adjust printer properties.

9.13.2 PrintText

The PrintText macro allows you to print the string written in the field text. The option silent (default value is
true) allows, if set to false, you to open a dialog at runtime which asks the user to adjust printer properties.

NOTE  PrintText work in line printing mode using a standard protocol common to all printers that support it.
No custom drivers required for line printing.

NOTE In line printing, text is printed immediately line by line or after a timeout custom for each printer
model (could take also minutes for some models not design for line printing).
9.13.3 EmptyPrintQueue

The EmptyPrintQueue macro allows you to empty the current printing queue. If the macro is executed in the
middle of the execution of a job, then the queue will be cleared at the end of the job.

9.13.4 PausePrinting

The PausePrinting macro allows you to put on hold the current printing queue. If the macro is executed in
the middle of the execution of a job, then the queue is paused at the end of the job.

9.13.5 ResumePrinting

The ResumePrinting macro allows you to start the queue if previously it was put on hold.

9.13.6 AbortPrinting

The AbortPrinting macro allows you stop the execution of the current job and remove it from the queue. If
the queue has another job, then, after aborting, the next one starts immediately.
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10 Using HMWIN Client

The HMWIN Client provides remote access to the Runtime, and is included in the HMWIN Studio installation.
The HMWIN Client consists of a simple standalone application; although it uses the same graphic rendering
system as the server, it relies on a specified Runtime as Server for live data.

HMWIN Clientfor Windows is available in the Runtime folder of the HMWIN Studio root folder. Execute the
HMWIN Client application from the Runtime folder or from the start up menu (HMWIN Studio- HMWIN
Client). The client will open in a browser-like style window. Type the server IP address (the panel’s IP
address) in the address bar (for example: http://192.168.1.12). The Client will connect to the server and the
same graphical application running on the Server panel will be loaded in the client window.

HMWIN Clientacts as a remote client and communicates to the server, sharing the local visualization with
those Tag values that are maintained or updated by the communication protocol.

The HMI projects contain properties that let you know which page is currently displayed on the HMI and to
force the HMI to switchto a specific page. These properties can be used to synchronize pages showed on
the HMI and HMWIN Client or to control an HMI with a PLC. Please refer toSyncOptionsfor more details.

NOTE If any of the project files downloaded fromHMWIN Studio to the hmi panel change for any reason
(because corrupted or because has been manually changed via FTP client for example) an error message
appears into theHMWIN Client while downloading project. Error message appear like a “checksum does not
match”.

10.1 The HMWIN Client toolbar

The HMWIN Client toolbar contain following:

- URL related to the hmi panel address

- Aled indicating network requests. During data exchange the led becomes red.

- Reload button, useful for forcing project reload. Use “F5” to reload project from cache (simple reload
of project) or “Shift” + “F5” to force a full clean redownload of project to the client (useful when
project is changedin the target).

- Bookmark

- Settings

Panel Address ©  hitp://122. 168,40, 16 -9 @ -1 &

Figure 120

10.2Settings &Time Zone Options

HMWIN Clientprovides an additional option to handle the visualization of the timestamp information of a
project and to configure client settings.

From the Settings dialog you now have access to a set of new options:

- Update Rate (default 1 second): polling frequency used by HMWIN Client to synchronize data from
server.

- Time Out (default 5 seconds): max time wait from HMWIN Client before considering a request lost
and repeating it.

- Reuse connection: allow to reuse the same TCP connection for multiple HTTP requests reducing
network traffic and latency. Please note that in some circumstances, enabling this option can lead to
the opposite result: very high latency. In particular this can happen when connecting through a HTTP
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proxy, like often seen in 3G connections, if proxy server is not immediately terminating old requests
(causing server to saturate the available connection sockets).

- Enable compression: enabling this flag can improve download times on very slow connections. For
LAN ones, the cpu overhead required to accomplish compression server side is just too high. So by
default the flag is disabled.

- Time Settings:information is used by the client to adapt the widget timestamp information according
to the desired behavior. Options for Time Settings:

Use Widget For each widget use time information according to the widget settings
Defaults provided at the time of programming.

Translates all timestamps used in the project into the PC local time

Local Time where the client is installed.
Global Time Translates all timestamps used in the project into UTC format.
Server Time Translates all timestamps used in the project into the same used by HMI

panel/server in order to show the same time.

NOTE This feature requires you to set the HMI RTC with the correct time zone and DST (Daylight Savings
Time) options.

10.3Workspace

Using HMWIN Client, project files will be uploaded from panel and placed into a cache directory.
Cache folder where project are temporary stored is under:
o %appdata%\Panasonic\[build number]\client\cache

where [build number] is a folder named as build number like 01.90.00.608.
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11 Using the Integrated FTP Server

The HMI Runtime system features an integrated FTP server that can be used to get access to the internal
flash disk data.

NOTE Folders present on the Flash disk external to the runtime directory are not accessible via FTP;
external USB drive and SD Storage Card are not accessible via FTP.

You can use any standard FTP client program to connect to the panel FTP server. The FTP server responds
to the standard port 21 when using the IP address assigned to the panel as host.

NOTE The server supports only ONE connection at a time; if you are using an FTP client which is
configured to multiply the connections to the server in order to speed up the transfer operation, you will need
to disable this feature in the client program or set the maximum number of connections per session to 1.

The FTP server is configured by default to accept incoming connection from the following account (when
User Managemnt/Security is disable):

e User name: admin

e Password: admin

FTP permissions and account information can be changed from the “UserGroups” under the “Security” item
of the project folder as shown in the following figure.

ProjectView a x 1:Projectl* T 1:Page1’yy UserGroups x]

+ +
[ Name | Authorized  |Comments [ Authorization Settings [
Hadmin true administrator group dminAuth [
quest true guastfuth
unautharized false unauthorizedAuth

| widget I Actiory| Ftp ||Ht1:p | Miscellaneous|
S

2 MultiLanguage Permission: Al

Securi
Jg UserGroups RootFolder: /
Users

AuditTrail Common to all user groups
; + = Allow Al
----- ™ Recipes

..... [ Dictionaries IPAdress
----- /™ DialogPages

----- % Page Templates
=7 Keypads

23 MNumeric

Figure 121

Additional information can be found later in this document in the chapter titled “FTP Authorizations”.
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12 Using ActiveX Client for Internet Explorer

In the standard distribution of HMWIN Studio, a HMWIN Client and an ActiveX Client is provided. ActiveX
components are NOT installed by default to the Target devices, in order to save space in the flash memory.

12.1Installing ActiveX

The ActiveX component is distributed with the HMWIN Studio installation package. The related files are
located in the Runtime folder of the HMWIN Studio installation directory. The files, “HMIAX.cab" and
“‘HMIClientAX.html", should be copied into the workspace folder of the Target device, where the Runtime is
installed. The file copy can be done using the panel FTP server.

Starting from v1.90 (b608) of HMWIN Studio has been introduced software plug-in support (ref. to chapter
on software Plug-ins chapter for more details) to simplify ActiveX installation. Just enable ActiveX plug-in
from project properties and install/update runtime to add ActiveX files to the runtime and transfer it into the
target without the need of manual copy of it via FTP.

NOTE This ActiveX requires Microsoft Visual C++ 2008 Redistributable Package (x86) installed on your

system. You may need to download the Microsoft Visual C++ 2008
Redistributable Package (x86) from the Microsoft web site.

NOTE The ActiveX plug-in require about 10MB of space. Enable it only if required by the HMI application to
keep the smallest footprint for the application.

12.2HTTP Access to ActiveX files

When security is enabled, ActiveX files “HMIAX.cab” and “HMIClientAX.html” have tobe accessible from the
http server embedded into the runtime. Refer to HTTP Authorizations chapter for more details.

12.3Internet Explorer Settings

Internet Explorer settings must be changed adding the panel’s IP to the list of the trusted sites.

In Tools — Internet Option Security tab choose “Trusted sites". Then click on the “Sites" button. Type in the IP
address of the Target device the location where the ActiveX component has been installed and it will be
loaded to the browser.
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Internet Opticns

T

General | Security |F‘riuacy | Content I Connections I Programs I Advanced |

o -

Internet Local intranet

Select a zone to view or change secyrity settings.

o

Restricted
sites

J 1
Trusted sites
Trusted sites

This zone contains websites that you 2
trust not to damage your computer or

Add this website to the zone:

fwebsites:

http://192.168.5.12

Figure 122

You can add and remove websites from this zone. All websites in
this zone will use the zone's security settings.

Remowve

[ Require server verification {https:) for all sites in this zone

12.4Security Setting for Trusted Site Zone

Set your Internet Explorer Browser as seen in the following images:
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Internet Options
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General | Security |Pri'«'aq‘|I I Co